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About This Book

IBM® Personal Communications for Windows® reference books are comprised of
four volumes: a 3270 Emulator User’s Reference, a 5250 Emulator User’s Reference,
a VT Emulator User’s Reference and an Administrator’s Guide and Reference.
These volumes provide information for using IBM Personal Communications
AS/400® for Windows operating systems (hereafter called PC400) and IBM
Personal Communications for Windows operating systems. In this book, Windows
refers to Windows 95, Windows 98, Windows NT, Windows Me, Windows 2000,
and Windows XP. When information is applies only to a specific operating
systems, this is indicated in the text. PC/3270 refers to the 3270 portion of the
combined package. Throughout this book, workstation refers to all supported
personal computers. When only one model or architecture of the personal
computer is referred to, only that type is specified.

Who Should Read This Book
This book is intended for the person who uses Personal Communications on a
workstation to access hosts using 3270 terminal emulation.

How to Use This Book
This book contains reference information that you might need to refer to when
installing or operating Personal Communications.

Personal Communications is designed to use various communication adapters and
to work with other workstation and host system software. Refer to the appropriate
documentation for the products you use.

Command Syntax Symbols
Parentheses, brackets, ellipses, and slashes have the following meanings or uses:

( ) Parentheses enclose operands that govern the action of certain command
options.

[ ] Brackets indicate an optional command argument. If you do not use the
optional item, the program selects a default.

... Ellipsis after an argument indicates that you can repeat the preceding item
any number of times.

/ For 3270, a slash must precede the Time Sharing Option Extensions
(TSO/E) password. A slash must also precede parameters of DOS
commands entered from the command line.

\ A backslash is included as part of any directory name. An initial backslash
indicates the first-level directory, and an additional backslash is inserted in
the directory name to indicate another level.

All directives, operands, and other syntax can be typed in either uppercase or
lowercase, unless otherwise indicated.

© Copyright IBM Corp. 1989, 2002 ix
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Where to Find More Information

This section discusses getting help when you are installing, configuring, or using
Personal Communications.

Online Help
The help facility describes how to install, configure, and use Personal
Communications. Online help is very extensive and includes information about
every aspect of configuring and using Personal Communications.

Use help to obtain the following information:
v Menu choices
v Operation procedures
v Operations in windows
v Meanings of the terms displayed in windows
v Causes of errors and the corresponding actions to take
v Mouse-based operations
v Operation without a mouse
v Detailed explanations of specific terms
v Further technical information about Personal Communications
v Detailed explanations of operator information area (OIA) messages

To display online help, select choices from the Help menu or press F1.

You can use Personal Communications online help just as you use the online help
for Windows.

Messages and Alerts
Online messages are displayed by Personal Communications, but a message does
not always mean an error occurred. For example, a message might tell you that an
operation is in progress or has been completed. A message can also prompt you to
wait for the completion of an operation.

Messages That Appear in Pop-Up Windows
While using Personal Communications, you may see messages appear in pop-up
windows, but not necessarily as a direct result of your actions. These messages can
appear for a number of reasons, outlined in the following sections.

System-Fault Messages
For Windows NT®, if a message does appear in a pop-up window, you can paste
its contents into the Windows NT clipboard. To do this:
1. Click Details on the pop-up window.
2. Mark the text that you want to copy.
3. Click the marked text with the right mouse button and then click Copy.
4. Start an editor, such as Notepad, and click Paste from the Edit menu.
5. Save the file in case an IBM Service Representative needs this information to

diagnose your problem.

© Copyright IBM Corp. 1989, 2002 xi



Security-Related Messages
Personal Communications optionally utilizes Secure Sockets Layer (SSL) to
establish sessions with servers; this may require input from you (for example, a
password). Refer to the Administrator’s Guide and Reference for details.

System-Policy-Related Messages
Your Personal Communications workstation configuration can be controlled
centrally using facilities for managing system policies. Refer to the Administrator’s
Guide and Reference for details.

OIA Messages

Personal Communications displays messages in the operator information area
(OIA) or in a pop-up window. Messages from Personal Communications are
displayed in the message window; messages from the host system regarding the
condition of the session are displayed in the OIA of the session window.

The OIA is the bottom line of the session window. An OIA message indicates the
status of Personal Communications as well as information about the workstation,
host system, and attachment method.

All of the OIA indicators, reminders, and messages are described in the online
help. To view this information:
1. Select Index from the Help menu.
2. Select The operator information area messages.

To look up a specific OIA message, select Search. When the Search window
appears, type the letters that appear in the OIA. For example, MACH or PROG. If a
lightning bolt appears, type COMM.

3. Double-click the index entry that matches your search.
4. Scroll through the window until you find the number that appears in your

OIA.

Alerts
Alerts may be generated which correspond to specific Personal Communications
messages. See the Administrator’s Guide and Reference for more information.

Personal Communications Library
The Personal Communications library includes the following publications:
v IBM Personal Communications for Windows, Version 5.6 CD-ROM Guide to

Installation, GC31-8079-07
v IBM Personal Communications AS/400 for Windows, Version 5.6 CD-ROM Guide to

Installation, GC31-8080-07
v IBM Personal Communications for Windows, Version 5.6 Quick Beginnings,

GC31-8679-03
v IBM Personal Communications for Windows, Version 5.6 Access Feature, SC31-8684-03
v IBM Personal Communications for Windows, Version 5.6 5250 Emulator User’s

Reference, SC31-8837-01
v IBM Personal Communications for Windows, Version 5.6 3270 Emulator User’s

Reference, SC31-8838-01
v IBM Personal Communications for Windows, Version 5.6 VT Emulator User’s

Reference, SC31-8839-01
v IBM Personal Communications for Windows, Version 5.6 Administrator’s Guide and

Reference, SC31-8840-01
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v IBM Personal Communications for Windows, Version 5.6 Emulator Programming,
SC31-8478-06

v IBM Personal Communications for Windows, Version 5.6 Client/Server
Communications Programming, SC31-8479-06

v IBM Personal Communications for Windows, Version 5.6 System Management
Programming, SC31-8480-06

v IBM Personal Communications for Windows, Version 5.6 CM Mouse Support User’s
Guide and Reference

v IBM Personal Communications for Windows, Version 5.6 Host Access Class Library,
SC31-8685-03

v IBM Personal Communications for Windows, Version 5.6 Configuration File Reference,
SC31-8655-05

These books are also available (except in DBCS versions) in PDF format and are
optionally installed or viewed from the CD-ROM.

In addition to the printed books, there are HTML documents provided with
Personal Communications:

Host Access Class Library for Java™

This HTML document describes how to write an ActiveX/OLE
2.0–compliant application to use Personal Communications as an
embedded object.

Host Access Beans for Java
This HTML document describes Personal Communications emulator
functions delivered as a set of Java Beans.

Where to Find More Information xiii
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Chapter 1. Personal Communications Highlights

The information in this book applies to PC/3270, unless otherwise indicated. Each
CD-ROM package supports multiple languages with a single level of data
encryption.

Personal Communications brings the power of personal networking to your
workstation by providing a variety of connectivity options supporting local area
network (LAN) and wide area network (WAN) environments. Whether you need
host terminal emulation, client/server applications, or connectivity, Personal
Communications offers a robust set of communications, networking, and
administrative features.

Personal Communications is a full-function emulator package with an easy-to-use
graphical interface, which includes many useful features such as file transfer and
dynamic configuration, and emulator APIs including the IBM Host Access Class
Library.

Personal Communications also provides a variety of SNA-based client application
programming interfaces (APIs). You can create applications that use the
peer-to-peer client APIs, which are based on LU 6.2 (and provided by Personal
Communications). Using these APIs you can simultaneously access and process
information on peer workstations.

With Personal Communications, you can participate in Advanced-Peer-to-Peer
Networks (APPN) as an end node, and use the advanced network features,
high-performance routing (HPR), and dependent LU requester (DLUR).

Personal Communications provides the following functions:
v System/390® Connections

LAN LAN via IEEE 802.2
3270 Communications Server for Windows NT
Telnet3270
3270 via AS/400
APPC 3270 via LAN
Microsoft® SNA client over FMI
Dependent Logical Unit Requester (DLUR)
VT-over-Telnet (TCP/IP)
3174 Peer Communication

COAX SNA Distributed Function Terminal
Non-SNA Distributed Function Terminal

COM port
Telnet 3270
SNA-over-Async
IBM Global Network® (not in Japan)
Home3270
IBM Global Network - SNA-over-Async
Dependent Logical Unit Requester (DLUR) via

SNA-over-Async

Hayes AutoSync
APPC 3270 via SNA-over-Async
APPC 3270 via Hayes AutoSync
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VT-over-Async
VT-over-Telnet (TCP/IP)
X.25 Hayes AutoSync
X.25 DLUR via Hayes AutoSync
X.25 APPC 3270 via Hayes AutoSync

5250 3270 via AS/400
Dependent Logical Unit Requester (DLUR)

SDLC Synchronous Data Link Control
3270 via AS/400 (passthru)
APPC 3270 via SDLC
Dependent Logical Unit Requester (DLUR)

SNA/IP
LU 0, 1, 2, 3
APPC 3270
LU 0, 1, 2, 3 via DLUR

IBM ISA/MCA WAC
Synchronous Data Link Control
3270 via AS/400 (passthru)
APPC 3270 via SDLC
Dependent Logical Unit Requester (DLUR)
X.25 Qualified Logical Link Control
X.25 3270 via AS/400
APPC 3270 via X.25
X.25 DLUR
Communications Server Client
Communications Server

IBM-EEDLC
LU (0, 1, 2, 3) via DLUR
APPC 3270

OEM LU (0, 1, 2, 3)
3270 via AS/400 (passthru)
APPC 3270
Dependent LU Requester (DLUR)

v AS/400 Connections
LAN LAN via IEEE 802.2

Telnet5250 over TCP/IP
VT over Telnet
Telnet5250 over IPX/SPX

5250 Twinaxial Data Link Control (APPC)
Twinaxial Data Link Control (Console)

COM port
SNA-over-Async
Hayes AutoSync
SNA-over-Async (Console)
VT over Async
VT over Telnet
Telnet 5250
X.25 Hayes AutoSync

SDLC Synchronous Data Link Control
SNA/IP

5250
IBM ISA/MCA WAC

Synchronous Data Link Control (WAC)
X.25 Qualified Logical Link Control

IBM-EEDLC
5250
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OEM APPC 5250
v ASCII Emulator Connections

LAN VT over Telnet
COM port

VT-over-Async
VT over Telnet

v S/3X Emulator Connections
5250 Twinaxial Data Link Control (Console)

v Client/Server Connections
LAN LAN via IEEE 802.2
Twinaxial

Twinaxial Data Link Control (APPC)
COM port

SNA-over-Async
Hayes AutoSync
X.25

SDLC Synchronous Data Link Control
IBM WAC

Synchronous Data Link Control
X.25

AnyNet® SNA over TCP/IP
APPC

Enterprise Extender
HPR over IP

v Configuration of SNA Node (APPN) Sessions
– Emulator
– Client/server applications

v SNA Node Operations
– Starting and stopping resources
– Deleting resources
– Displaying resource information
– Changing session limits
– Initiation of path switches

v Log Viewer
– View Message Log, Trace Log, and Merged Log files
– Summary and Detail views
– Set default Message Log size and location
– Filter and search Log files
– Message Log entries Help

v Trace Capability
– 3270/5250 emulator data
– APPN® and APPC API data
– Connectivity data, such as LAN or SDLC
– User services data, such as node initialization

v APPC Applets
– Display SNA sense data (GETSENSE)
– Transfer files (AFTP and AFTPD)
– Check connection (APING)

v Sample Programs

– Located in \Personal Communications\samples subdirectory
v Installation and Configuration

– Partial installation option
– Program sharing on a network server
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– Automatic detection of installed communication adapters
– Dynamic change of communication configurations
– Automatic Dial Facility (Async (IGN), SDLC, Home3270, SNA-A)
– Silent Installation
– ASCII SNA-node configuration
– Verification of ASCII configuration

v OEM Adaptor Cards

An open API enables vendors and other equipment manufacturers (OEMs) to
provide adapter cards that allow for additional connectivity options, for
example, additional X.25, ISDN, SDLC or twinax support.

v Host Session Function
– Up to 26 sessions
– Variable screen size and automatic font scaling
– Function settings (of the host code page, for example) for each session

v Host Graphics Support
– Built-in vector graphics support for GDDM® and other graphics applications

v File Transfer Function
– Easy operation through graphical user interface (GUI) windows
– Batch transfer of multiple files
– Concurrent file transfer through multiple sessions
– Background file transfer
– File transfer invocation by macro
– OfficeVision/MVS™ Import/Export functions
– VT File Transfer (XModem and YModem)

v Edit (Cut and Paste) Function

You can use the clipboard to cut, copy, and paste a selected area.In addition, you
can paste data in other applications, such as spreadsheet programs, that support
the PasteLink function.
– Support of spreadsheet data format (Sylk, Biff3, Wk3 formats)
– Copy Append
– Paste Next
– Paste to Trim Rectangle
– Paste Stop at Protected Line

v Graphical User Interface (GUI)
– Customizable 3D iconic tool bar
– 3D-button hotspots
– Pop-up keypad
– Macro function, including record and play
– VBScripts, including record and play
– Keyboard-function setup and remapping
– Mouse-button-function setup and remapping
– Display setup (cursor type, graphics, sound, colors, for example)
– Automatic font size adjustment or fixed font size
– Window-appearance setup
– Menu-bar customization
– 3270 Light Pen emulation by using a mouse
– Status bar with history
– Page setup (Text and Graphics)
– Revised Configuration Dialog
– Online help

v Print Function
– Printer session (for PC/3270: SCS, LU 3, or non-SNA)
– Graphics local print
– Printing with the Windows NT printer drivers
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– Print function by printer definition table (PDT)
– Multiple host-print functions in multiple sessions
– Print-job control by SNA bracket timeout
– PDF-to-PDT conversion tool
– PC400 print function by OS/400® Host Print Transform (HPT)
– PC400 printing supported by the AS/400 Advanced Print Support Utility
– ZipPrint

v Programming Interfaces
– 16/32-bit Emulator High-Level Language Application Programming Interface

(EHLLAPI)
– 16/32-bit Dynamic Data Exchange (DDE)
– 32-bit Node Operations Facility (NOF)
– 16/32-bit Personal Communications API (PCSAPI)
– 32-bit Advanced Program-to-Program Communication (APPC)
– 32-bit Common Programming Interface for Communications (CPI-C)
– 32-bit Automation Object API
– 32-bit ActiveX/OLE 2.0
– Host Access Beans for Java
– ActiveX Controls

v PC400 Client Function
– Data transfer
– PC Organizer
– Text Assist
– Enhanced Programmable Terminal User Interface (ENPTUI)
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Chapter 2. Problem Analysis

This chapter describes the information that will help you analyze problems with
Personal Communications, and ways to report a problem to IBM. For detailed
information about contacting IBM, refer to Quick Beginnings.

For information about Personal Communications and support, refer to the
following Web sites:
v The Personal Communications home page provides access to general product

information, and download services. To view this page, use an Internet browser
and go to the following Internet address or Universal Resource Locator (URL):
http://www.ibm.com/software/network/pcomm

v The Personal Communications support page provides links to code fixes, tips,
newsgroups, support options, and services. To view this page or to submit a
software defect report, use an Internet browser and go to the following Internet
address:
http://www.ibm.com/software/network/pcomm/support

Personal Communications provides several utilities to help you with problem
analysis. They can be invoked by selecting their icons from the Programs > IBM
Personal Communications → Administrative and PD Aids subfolder on the
Windows Start menu.

The following sections describe these utilities and how to use them.

Log Viewer
The Personal Communications log viewer utility enables you to view, merge, sort,
search, and filter information contained in message and trace logs. Use the log
viewer during problem analysis to work with message and trace log entries. The
default name of the message log output file is PCSMSG.MLG; its file extension
must be .MLG. The file extension for trace logs must be .TLG.

To view message or trace logs:
1. From the Administrative and PD Aids subfolder, click Log Viewer; or, from an

active session, click Actions > Launch → Log Viewer.
2. From the list of logged messages, double-click a message to display the

message text.

For more information about log viewer functions, see Chapter 7, “Log Viewer
Functions” on page 91.

Trace Facility
The Personal Communications trace facility enables you to log trace information
for certain Personal Communications functions.

To start a trace, perform the following steps:
1. From the Administrative and PD Aids folder, click Trace Facility; or, from an

active session, click Actions → Launch → Trace Facility. The trace status on the
title bar displays the current state:
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Active Trace data is being collected by the trace facility.

Inactive
No trace data is being collected.

2. From the main dialog box, click Set Up to set the desired trace system
parameters.

3. Click OK to return to the main trace dialog box.
4. From the main trace dialog box, select the type of data you want to trace from

the Function Name, Component Name, and Trace Option list boxes.

Function Name
A specific set of Personal Communications features, such as 3270/5250
Emulator or User Services.

Component Name
The name of a specific part of a function, such as API data (for the
3270 Emulator function) or Node Initialization (for the User Services
function).

Trace Options
The options associated with a particular component, such as EHLLAPI
(for the API component) or API trace (for the Node Initialization
component).

5. Start tracing data by clicking Start, or apply changes to the trace options by
clicking Apply.

6. Run the operation that you want to trace.
7. Optionally, stop the trace by clicking Stop.
8. Save the trace data to your hard disk by clicking Save.
9. Click Format to specify a formatted trace file name and to format the trace

data. The Information Bundler utility should be used immediately after the
trace is complete to ensure that the correct information is gathered.

Note: If you have changed the default path for the formatted trace file, the
Information Bundler will not find the trace information. Copy the trace
files to the system-class application data directory.

10. Click OK.
11. Click Clear to clear the trace buffer where you saved a trace.
12. Use the log viewer to view the formatted trace log.

Information Bundler
The Personal Communications Information Bundler utility gathers system files,
trace and log files, and registry information and creates a self-extracting .EXE file.
This .EXE file is sent to support personnel via FTP for problem resolution. This
utility should be executed immediately after the trace is complete to ensure that
the correct information is gathered. To use the information bundler utility:
1. From the PD Aids folder in the Personal Communications program group,

double-click the Information Bundler icon; or, from an active session, click
Actions → Launch > Information Bundler.

2. A .EXE file containing system and Personal Communications information is
created in the Personal Communications system-class application data directory.
By default this file is called X12345.EXE. Refer to the installation documentation
for the location of the system-class application data directory for each Windows
operating system.

10 Personal Communications 3270 Emulator User’s Reference



Internet Service
The Internet Service utility enables you to send the .EXE file containing diagnostic
data collected by the Information Bundler to an FTP server. This utility will not
work unless TCP/IP is configured and you have a direct connection to the internet.
To use Internet Service:
1. Double-click the Internet Service icon located in the Personal Communications

program group; or, from an active session, click Actions → Launch → Internet
Service.
The Internet Service window contains four data fields that must have valid
values before you can submit your problem report.

2. Verify that the FTP Address field contains the default address
testcase.software.ibm.com. This is the service anonymous FTP server.

3. Type your e–mail address in the field provided.
4. In the Problem Determination Filename field, type the file name and path of

the .EXE file created with the Information Bundler. This file is located in the
Personal Communications installation directory.

5. In the PMR Number field, type the PMR number that you received as a result
of contacting IBM support personnel.

6. When all fields in the window have been filled with valid values, click
Transmit to submit your problem determination information.
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Part 2. Using Personal Communications
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Chapter 3. Considerations for Using PC/3270 Sessions

This chapter contains hints and tips for using PC/3270 sessions.

Supplementary information other than the items described in this book may be
included in README.TXT in the Personal Communications directory.

Power Management
Personal Communications complies with Windows 2000 Power Management
requirements for handling sleep events. This support minimizes session
interruptions due to network disconnections caused by sleep on Windows 2000
and subsequent versions.

Note: In this context, the term ″sleep″ means that the system is on standby or is in
hibernation. To applications such as Personal Communications, standby and
hibernation are the same.

The benefits of this power management system include the following:
v Power consumption is reduced via the Advanced Configuration and Power

Interface (ACPI); the system is able to enter a lower power state (or sleep mode)
that appears to be ″off″ but is still powered enough to enable the system to
power up (or wake) to handle timed events or device related needs such as
receiving a fax.

v The PC is instantly available to the user because it can rapidly return from a low
power state to a fully-functional state.

v Customers can rely on their PCs to power down and up in a way that is easily
understood and predictable.

The following Personal Communications components are affected by this Power
Management arrangement:
v Emulator sessions
v Transfers that utilize an emulator session

Sleep Permission
Before entering a sleep state (stand by or hibernate), Windows 2000 normally
requests permission from the applications that are running. When one or more
emulator sessions are connected and Windows signals that the user is available for
interaction, Personal Communications asks the user to grant or deny sleep
permission. If the user grants permission, Personal Communications logs the event
and then notifies Windows. When user interaction is not possible, sleep permission
is denied.

When Personal Communications is not in the connected state, Windows 2000 may
automatically sleep, without prompting the user for permission.

Critical Sleep
When Windows 2000 resumes after an emergency suspension, Personal
Communications may display and log a warning message.
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Host-Session Window Operations

Cursor Color
PC/3270 assigns white to the cursor color as the product default, and mixes the
background color (if it exists) with an XORed (exclusive or) operation. If you want
to change this default cursor color assignment, modify the PCSWIN.INI file and
insert the following line into the [Session] section:

[Session]
CursorColor=<red-value> <green-value> <blue-value>

Where <red-value>, <green-value>, and <blue-value> are integers from 0 to 255
that specify the color intensity for each color primitive respectively; 0 0 0 for black,
and 255 255 255 for white.

Releasing Insert Mode with Attention Keys
As on a non-programmable terminal, you can release insert mode when you press
an Attention key. If you want this to happen, add this parameter to the [Keyboard]
section of the workstation profile (*.WS):

[Keyboard]
ResetInsertByAttn=Y <- Added.

Scroll Bar
If you choose Font from the Appearance menu in the host session window and
choose Fixed Size from the Select Display Font window, the entire operator
information area might not appear on the screen. If you specify With Scroll Bar,
the OIA will not scroll. The session window size is restricted to be smaller than the
screen size.

Scroll-Lock Key
When the Scroll Lock keyboard indicator is turned on, the cursor movement keys
and the Page Up and Page Down keys are used to scroll windows only when you
specify With Scroll-Bar in the Window Setup window. If you specify Without
Scroll-Bar, you cannot use the Scroll Lock key, because the entire screen is
displayed. For example, cursor-movement keys do nothing in Scroll Lock mode.

3270-Session Screen-Size Control
Although you can specify the screen size of the 3270 session in the PC/3270
configuration, the final screen size is determined by the host according to the SNA
BIND negotiation.

Sometimes, you might want to use a particular screen size when it is difficult to
have the host VTAM® table changed. The following method will satisfy your
requirement; however, because it violates SNA rules, some applications that refer
to the VTAM table only might not work.

Modify your workstation profile (.WS) to insert the following line into the [LU]
section:

[LU]
InfScreenSize=Y

Personal Communications processes byte 24 of the host BIND image correctly and
according to the SNA architecture. Byte 24 is the last 2 bytes of
PSERVIC=X’028000000000000000000300’ (03 in this case) in the log mode.
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If byte 24 is X'03', the default screen size is 24 x 80 and the alternate is what you
configured with PC/3270.

If byte 24 is X'00' or X'02', the default and alternate screen sizes are 24 x 80.

If byte 24 is X'7E' or X'7F', bytes 20–23 in the BIND control the default and
alternate screen sizes.

If you have X'03' in the BIND image, you can customize whatever screen size you
want. The host will query Personal Communications and use the alternate screen
size.

The following table shows the details of the BIND image processing:

Byte in BIND by Host ==> Result (Screen size)
-------------------- --------------------

24 20 21 22 23 Default Alternate
== == == == == ======= =========

a) 00 -- -- -- -- ==> 24 x 80 24 x 80

b) 02 -- -- -- -- ==> 24 x 80 24 x 80

c) 03 -- -- -- -- ==> 24 x 80 R x C

d) 7E Rd Cd -- -- ==> Rd x Cd Rd x Cd

e) 7F Rd Cd Ra Ca ==> Rd x Cd Ra x Ca

Legend: RxC: Screen Size defined by PC/3270 configuration
(R,C) = (24,80) , (32,80) , (43,80) or (27,132)

Rd: Rows in the default screen size mode
Cd: Columns in the default screen size mode

(Rd,Cd) = (24,80) , (32,80) , (43,80) or (27,132)
Rd*Cd <= R*C

Ra: Rows in the alternate screen size mode
Ca: Columns in the alternate screen size mode

(Ra,Ca) = (24,80) , (32,80) , (43,80) or (27,132)
Ra*Ca <= R*C

PC/3270 supports Query Replies. Make sure that the Query Reply of Implicit
Partition returns the final screen size upon receipt of the BIND command.

Customizing a Display Translation Table
PC/3270 displays the host EBCDIC character using the workstation (ANSI) graphic
symbol so that the character defined by the S/390® EBCDIC host code page is
displayed correctly using the same graphic symbol defined by ANSI. However,
you might need your original translation, because your host or workstation
application is not designed to use the standard translation.

You can use your original translation table if you refer to the following procedure
as an example. Note that the data integrity caused by the user-defined table is
your responsibility.
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The following procedure is an example of how to remap left and right brackets.
1. Terminate all running 3270 sessions
2. Modify the PC/3270 workstation profile (*.WS).

[Translation]
IBMDefaultView=N
DefaultView=C:\Personal Communications\PRIVATE\BRACKET.XLT

3. Create the display translation table file (.XLT). In this example, the following
BRACKET.XLT file is created in the Personal Communications private
subdirectory.
[Profile]
id=XLT
Description=User-defined Display Translation Table

[Option]
Replace=Y

[SB Xlate]
; EBCDIC=ANSI
; The next line displays EBCDIC X’AD’ as
; an ANSI X’5B’ (left bracket)
AD=5B
; The next line displays EBCDIC X’BD’ as
; an ANSI X’5D’ (right bracket)
BD=5D

4. Create your own keyboard layout (.KMP) if you need to enter your new left
and right brackets graphic symbols:
[Keyboard]
KEY27=ansi dd
KEY28=ansi a8

The information on the right should be lowercase characters. PC/3270
translates ANSI X'dd' into EBCDIC X'ad'. It is displayed as [ by the table
created in step 3.

5. Click on the PC/3270 icon corresponding to the modified workstation profile.

Support for Long File Names
Like Windows, Personal Communications supports long file names. You can give
any name (up to 255 characters) to a file; you are not limited to eight characters
with a three-character extension. You can use spaces in the file name, but not the
symbols /, \, :, *, ?, “, <, >, or |. In addition, the tilde () character should not be
used in CMS or MVS host file names.

File Transfer Function

Host File Name and Reserved Words
You should not use the following words as a VM file name or file type, as a MVS
data set name, or as a CICS® file name, because they are reserved for use as option
commands:
v ASCII
v APPEND
v TIME
v CLEAR
v NOCLEAR
v SILENT
v QUIET
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v PROGRESS
v JISCII
v SO
v NOSO
v BLANK
v USER
v CRLF
v BINARY
v NOCRLF

Changing the Packet Size When Import/Export Is Idle
When import/export is idle, select Preferences → Transfer from the Edit menu.
When you change the packet size on the Setup window, end import/export, and
then rerun it.

Wait Option for Multiple File Transfer
If multiple file transfers do not succeed, insert the following statement into the
[Transfer] section of your .WS file:

[Transfer]
wait=1000

This parameter causes a 1000 msec (1 sec) delay between file transfers. If this does
not help, you might need to increase the value again.

NOTRUNC and BLANK Options (SBCS Only)
If you want to add trailing blanks (spaces) to fill the logical record length for each
record when downloading a text file, use the following options in the Additional
Options edit field of the Transfer-Type Definition window.

NOTRUNC : for VM/CMS (PTF# UR35492)
NOTRUNC : for MVS/TSO (PTF# UR34797)
BLANK : for CICS

Setting the VTAM PSERVIC Statement
File transfer problems can occur if extended attribute support has not been set on
in the VTAM PSERVIC statement. For extended attribute support, set on the high
order bit in PSERVIC byte1 (zero byte origin) as follows: x’xx80xxxxxx...’.

Graphic Functions
This section provides information, restrictions, and considerations for graphic
functions.

Graphics Protocols
Personal Communications allows you to use host graphics applications, such as
GDDM and others. Two types of graphics are supported:
v Vector
v Programmed symbols

Two protocols are supported for vector graphics:
v Advanced
v Native

Chapter 3. Considerations for Using PC/3270 Sessions 19



See Configuring Graphics in the online helps for a description of these protocols
and to learn how to configure your sessions for graphics.

The following functions are supported:
v Multiple mixed alphanumeric and graphics host sessions
v Use of standard OS/2® printing and plotting facilities
v Creation of PIF (Picture Interchange Format) files
v Clipping graphics data into the clipboard

Vector Graphics
Vector graphics are computer graphics in which display images are generated from
display commands and coordinate data. Personal Communications provides vector
graphics support for the OS/2-Link (advanced) or the 3179G or GOCA (native)
protocols. Choose the protocol that is appropriate for your host applications.

Advanced Protocol: Use the advanced protocol when you have GDDM Version 2
Release 3 or later and are using any of the following operating systems:
v MVS
v VSE
v VM/SP
v VM/XA SP™

Note: The advanced protocol is not supported by the CICS pseudo-conversational
mode with versions of GDDM earlier than Version 3, and not by IMS/VS at
all. It is, however, supported by the CICS pseudo-conversational mode with
GDDM Version 3 Release 1 or later.

The advanced protocol is equivalent to that used by OS/2-Link, so it supports the
same subsystems. However, no download of code from the host system is required
for Personal Communications because all the OS/2-Link graphics modules are
integrated into the program.

Native Protocol: Choose the native protocol when you intend to use older GDDM
versions or non-GDDM host-graphics applications, such as those originally
intended for use on 3270 nonprogrammable terminals as the 3179G, 3192G or
3472G. The native protocol also allows IMS/VS users to display GDDM graphics.

Note: A 3174 controller requires a terminal to respond within a certain time; if it
does not, a machine check 207 message appears. If you are using a coaxial
attachment for graphics in native mode, this can happen for various reasons,
such as the complexity of the graphics drawing-orders or the speed of your
workstation. In this case, you should change to advanced mode.

Programmed Symbols
Raster graphics are displayed with programmed symbols, which are downloaded
to your workstation. Personal Communications support up to six sets (PSA
through PSF) of triple-plane and multiple-color programmed symbols.

Use programmed symbols as the graphics type when you intend to use host
graphics applications originally written for the 3279G terminal.

Graphics applications use one or both of these methods to display graphical
screens. Personal Communications allows you to enable or disable support for
vector graphics and programmed symbols. Choose the type of support that our
host applications require.
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Note: If you use the OS2-Link (advanced) protocol under the GDDM program, do
not choose programmed symbols. Also, do not choose programmed symbols
when you use the OS2-Link protocol with other applications.

Enabling Programmed Symbol Sets: PC/3270 provides up to six sets of
triple-plane programmed symbols, depending on the type of graphics support that
you choose. By default:
v Two sets (PSA and PSB) of single-plane programmed symbols are usable if you

choose both programmed symbols and vector graphics.
v Three sets (PSA, PSB, and PSE) of single-plane programmed symbols and three

sets (PSC, PSD, and PSF) of triple-plane programmed symbols are usable if you
choose programmed symbols, but not vector graphics.

You can change the number of programmed-symbol sets and triple or single planes
available for each programmed-symbol set by editing the [3270] section of the
workstation profile:
PSSPlanes=xxxxxx

Each x represents a number (0, 1, or 3) that indicates how many planes are to be
available for each set; the first column indicates the number of planes for PSA, the
second column for PSB, and so on. For example, to enable six triple-plane
programmed symbol sets, enter the following:

PSSPlanes=333333

To enable two single-plane and two triple-plane sets, enter the following:
PSSPlanes=113300

How to Handle Errors Caused by Insufficient Memory
Graphic execution module PCSGRP.DLL uses a large amount of global memory for
graphic drawing or printing. When the workstation has insufficient installed
memory, results might not be correct. For example, an area might not be clearly
shaded.

In this case, increase the amount of installed workstation memory by at least
1 MB. For host graphic printing, add 1 more megabyte.

Memory might have to be further extended depending on the host graphic
application and printer driver used.

Drawing-Buffer Size
The drawing-buffer size varies depending on the contents set for Redraw of a
graphic function.

To set Redraw, click Preferences → Appearance → Display Setup from the Edit
menu in the session window. Select Graphics from Category.

Selecting Host from the optional items of Redraw requires no buffer.

If you select Retained, the graphic execution module stores all redrawing data into
a buffer. Such a buffer is called a retained buffer. The buffer size varies depending
on the complexity of the graphic data from an application program. For example, a
simple table has a buffer size of 10 KB to 20 KB, while a complicated graphic
image has a buffer size of 200 KB to 300 KB.
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When you select Bitmap to set Redraw, the buffer size will be the same as the sum
of the retained buffer size and compatible bit map size:

(Height) x (Width) x (Number of planes) x (Bits/Pixel) / 8 bytes

For example, when you select a 7x12 font for a VGA 16-Color Display Model 2
(24x80), the bitmap size is:

(7x80) x (12x24) x 1 x 4 / 8 = 80 KB

When you select a 12x20 font for an IBM PS/55 High-Resolution 256-Color Display
Model 2, the bitmap size is:

(12x80) x (20x24) x 1 x 8 / 8 = 460 KB

Using Bitmaps for Drawing
The graphic execution module uses a bit map compatible with the display unit to
draw an area instruction in overpaint mode. An image instruction requires one
plane bit map.

(Buffer for area) = (Area width) x (Area height) x (Number of planes) x
(Bits/Pixel) / 8

(Image buffer) = (Image width) x (Image height) / 8

Print Buffer Size
The retained buffer must be used for printing. The retained buffer is the same size
as that used for redrawing. This is also applied when you specified Bit Map for
Redraw on the Display Setup window.

If graphic printing is called in Bitmap mode, the graphic printing module
generates a bitmap compatible with the connected printer, draws an image on the
bitmap, and transfers the bit image to the printer.

This operation is generally performed quickly. When memory is frequently
swapped, the process slows down in proportion to the number of swap operations.
If a large bit map is not allocated, the graphic printing module prints a graphic
image normally using only the retained buffer.

Example:

Proprinter (240x144 DPI) character size:
Bitmap size = (240x8) x (144x11) x 1 x 1 / 8 = 380 KB

Example:

EPSON (ESC/P) (360x180 DPI color) character size:
Bitmap size = (360x8.5) x (180x11) x 3 x 1 / 8 = 2.3 MB

Note: With some printers, different printing results might be obtained in bitmap
mode and non-bitmap mode. If the desired results are not obtained, change
the current bitmap mode. For example, specify non-bitmap mode to print in
bitmap mode.
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Edit-Copy Buffer
An editing operation causes the graphic execution module to copy a bit map and
DIBitmap to the clipboard. The bit map is compatible with the display; DIBitmap
is a 4-bit/pixel bit map.

Printer Fonts
The printer driver can handle two font sets, the device font and GDI font. The
device font is a hardware font built into the printer. The GDI fonts are System
(without brackets) or other software fonts for Windows.

When you select a font set for graphic printing from the Printer Control window,
use the GDI fonts for the following reasons:
v In bitmap mode, a GDI font can be used for printing. However, the device font

cannot be used, because an image cannot be drawn on a memory bit map when
using the device font.

v In bitmap mode, the device font cannot be used for printing when OR and
exclusive OR attributes are mixed.

Plotter
Because a plotter does not support a raster, the following restrictions are imposed
on drawing. Use a plotter for figures and tables that have mainly lines.
v No shading is supported.
v Some shading patterns cannot be distinguished.
v Image order drawing requires much time, and the final printout is of poor

quality.
v The OR and exclusive OR are not correctly reflected.

Hole in Screen Caused by Clearing a Graphic Character
When a character overlaps a graphic image, the graphic image is cleared at the
position where the character is to be displayed. When you enter a null character or
space having the transparent attribute at the position where a graphic image is
displayed, the graphic image in that character cell is not cleared.

If you select Host or Retained to set Redraw on the Display Setup window, when
characters in a graphic image are cleared, a hole appears in the graphic area. This
is because these two modes do not have a bitmap image, and partial redrawing
cannot be performed on the screen.

If you select Bitmap mode as Redraw Graphics, you can find no hole on the
graphic region by the application that overrides any alphanumeric characters (as
well as NULL and SPACE) on the graphic image.

To restore the screen, perform either of the following actions:
v Press the PA3 key to have the application program redraw the screen.
v Minimize and restore the graphic image retained in Retained mode, then redraw

it or select Bitmap mode.

Note: When you change the setting of Redraw in the Display Setup window, the
set contents are valid from the next drawing.
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Miscellaneous Restrictions for Graphic Functions
If advanced protocol is selected, graphic functions cannot be used in the IMS/VS
and CICS pseudo-conversational mode with versions of GDDM earlier than
Version 3.

Considerations for Graphics Functions

Native-Graphics Datastream
If the host sends an Object Structured Field (Object Picture, Object Data, Object
Control) with a zero value in the length field, Personal Communications rejects it
and displays PROG754.

Printout to LPT1
When you use a host application that prints to your PC’s LPT1, you must first
select the printer in the Printer Setup dialog of the File menu.

Print Processing

Using a Printer with the Non-SNA DFT Attachment
For the non-SNA DFT attachment, PC/3270 regards any print job within 30
seconds after the previous one as a continuous job with the previous one. It
determines the job end artificially by a timeout value.

You can change the standard timeout value by modifying the [CNDFT] section of
the workstation profile (*.WS):

[CNDFT]
PrtTimeOut=nn

Note: The variable nn is the decimal value of the timeout in seconds.

Print Job Control Using SNA Timeout
PC/3270 treats the data packet, which begins with an SNA Begin Bracket (BB) and
ends with an SNA End Bracket (EB), as one job, and spools it to the Windows
print manager. However, some applications might not use SNA BB and EB
appropriately, and an unexpected page eject can occur. This section describes two
timeout controls that you can customize.

Concatenation of Multiple Print Jobs
When a new print job comes from the host before the timer specified by the
workstation profile expires, the job is concatenated to the previous one, and they
are regarded as one job. You can change the timer value by specifying the
following parameter in the [printers] section of the workstation profile (*.WS):

[printers]
ConcatenateTime=nn

Note: The variable nn is as follows; its unit is one second:

0 No concatenation of print jobs

1 – 32767 Concatenation of print jobs by this timeout value

When a non-SNA attachment is used, the timer should not be specified in the
workstation profile.
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Termination of a Print Job
If an end of a print job (SNA End of Bracket) does not come from the host before
the timer specified by the workstation profile has expired, the job is automatically
terminated. You can change the timer value by specifying the following parameter
in the [printers] section of the workstation profile (*.WS):

[printers]
TerminateTime=nn

Note: The variable nn is as follows; its unit is one second:

0 No automatic termination of a print job

1 – 32767 Automatic termination of a print job by this timeout value

When a non-SNA attachment is used, the timer should not be specified in the
workstation profile.

SCS TRN Command (LU 1)
You can change the operation of the SCS TRN command by adding a parameter to
the [printers] section of the workstation profile (*.WS):

ATRN=Y
Transfers data that is controlled by the SCS TRN command to the printer
driver without conversion. This parameter is the default for SBCS. In the
cases below, this parameter is assumed to be ATRN=N.
v The printer driver does not support PASSTHRU.
v The printer driver supports the BANDING function.
v BANDING=Y is specified in the [printers] section of the workstation

profile (*.WS).

When you use a printer driver for which the PASSTHRU function is
incomplete, sense code X'1003' is returned to the host system for the SCS
TRN command.

This is the default value.

ATRN=N
Converts data that is controlled by the SCS TRN command and transfers
the result to the printer driver. This parameter is the default for DBCS.

Note: The SCS TRN command (LU 1) is available in PDT mode only.

SCS SPD/SLD Command (LU 1)
If the selected font cannot be used with the values specified for CPI or LPI, this
command temporarily switches to a valid font.

Ignoring Blank Pages
If you cannot print a blank page correctly, check for the following things:
v Some printers ignore a blank page if so specified with the Printer Setup option

(or setting the printer’s DIP switches). Check whether the printer is set to enable
this option.

v Some printer drivers ignore a blank page if so set with the Printer Driver Setup
option. Check whether this option is supported by the printer driver.

Printing Reverse-Display Characters with GDI Fonts
Some printer drivers that do not support reverse-display character printing print
reverse-display characters as spaces. To avoid this, add the REVERSE=N line to the
[printers] section of the workstation profile (*.WS).
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CPI/LPI of Device Fonts
If the printer driver cannot use the device font for the specified CPI or LPI, data
can be printed with other CPI or LPI values.

Printing Reverse-Display Characters with Device Fonts
Most printer drivers do not support reverse-display-character printing with device
fonts.

PCSERR999 Error Messages
Message PCSERR999 - Personal Communications internal error: module-name -
xxx might appear when there is insufficient memory. Because the print job remains
in the print manager, you should delete it.

Printable Area
Characters might not be printed over a large enough area, depending on the
printer driver used. When using a printer driver that allows you to set the
margins, specify the minimum margins to maximize the printable area.

SVF Control Code
If the maximum print line (MPL) is less than the paper size in the SVF control
code, a page feed is performed when the printing position reaches MPL.

PDT Mode
Printing in PDT mode is restricted as follows:
v A graphic image is printed through the Windows printer driver specified in File

→ Printer Setup, even if the printer is set up for PDT mode.
v APL characters cannot be printed.
v PostScript printers are not supported.

SDDLU Considerations
PC/3270 supports the self-defining dependent logical units (SDDLU) function of
ACF/VTAM® Version 3 Release 4.1 (MVS) or Version 3 Release 4 (VM). SDDLU
provides the ability to dynamically create dependent LUs on predefined PUs and
to reconfigure dependent LUs without interruption to any other user on the
network and without intervention by system programming or operations staff.

PC/3270 SDDLU is supported for all connections except DFT (coaxial connection).

PC/3270 network stations support SDDLU by:
v Accepting a format-1 Activate PU (ACTPU), which signals that VTAM requires a

Network Management Vector Transport (NMVT) containing the Product Set ID
(PSID) and LOCADDR of the LU.

v Using LOCADDRs 02, 03, 04, and so on, in that sequence, by default. However,
if you specify the LU addresses explicitly, it will use the addresses that you
specify.

v Sending an unsolicited NMVT to VTAM when an LU switches on.

PSID Definitions
PC/3270 defines the default PSID for each LU type. Generally, the PSID contains
such things as the machine type and the model number. The following table
describes the machine type and model number definitions for each LU type
supported by PC/3270.
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Table 1. Machine Types and Model Numbers for Supported LU Types

Machine
Type

Model
Number LU Type Screen/Buffer Size

3270 002 Display Model 2 screen 24 rows by 80 columns

3270 003 Display Model 3 screen 32 rows by 80 columns

3270 004 Display Model 4 screen 43 rows by 80 columns

3270 005 Display Model 5 screen 27 rows by 132 columns

3270 DS2* Printer 3270 data stream 24 rows by 80 columns

3270 DS3* Printer 3270 data stream 32 rows by 80 columns

3270 DS4* Printer 3270 data stream 43 rows by 80 columns

3270 DS5* Printer 3270 data stream 27 rows by 132 columns

3270 00A Display 48 rows by 80 columns

3270 00B Display 62 rows by 160 columns

3270 00C Display 24 rows by 132 columns

* PC/3270 assumes that the 3270 data stream is the default printer-session type. If you use
the SNA Character String (SCS) data stream, you must use a different designation for the
PSID, such as 3270SCS. You must define this yourself, as shown in the next example.

Assigning User-Defined PSIDs
You can replace the default PSID values with your own definitions or define new
PSIDs, by preparing a PSID definition file or by changing the Windows
workstation profile. The PSIDs you use must be defined to VTAM.

Add a statement such as the following one to the [LU] definition in the
workstation profile. This example supersedes the default PSID with LUA0001.

PSID = LUA0001

Default Key Function Assignments
This section lists the functions assigned, by default, to each key on your keyboard.

For more information about each function, refer to the Keyboard choice on the
Help menu.

You can change the default key assignments to the following default function
tables, by selecting Keyboard Setup from the Assist menu.

When the Keyboard Setup window appears, select one of the following choices:
v 3270 for a 3270 keyboard layout
v 5250 for a 5250 keyboard layout
v 3270+5250 for a combined keyboard layout
v VT for a DEC VT220 keyboard layout

Personal Communications 5.6 includes two .KMP keyboard map files that map the
standard Win32 hotkeys for Cut, Copy, and Paste to Ctrl+X, Ctrl+C and Ctrl+V,
respectively. The key values for the following functions have also been changed:
Page Up (3270 only), Page Down (3270 only), Enter and New Line. You can utilize
these keyboard map files, or can add these key values to an existing map file.

For 3270 sessions, the .KMP file provided is pcswinkb3.kmp. The remapping is
given in the following table.
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Table 2. Win32 Keyboard Map Functions for a 3270 Layout

Function of Key Key

Edit Cut Ctrl+X

Edit Copy Ctrl+C

Edit Paste Ctrl+V

Page Up PF7

Page Down PF8

New Line Right Ctrl

Setting the 3270 Keyboard Layout Default
To make the 3270 keyboard layout defaults available, do the following:
1. Click Preferences → Keyboard from the Edit menu. The Keyboard dialog box is

displayed.
2. Select the IBM Default radio button next to Current Keyboard.
3. Click OK.

Default Key Functions for a 3270 Layout
Table 3 shows the default key functions for PC/3270. The key used is the same for
all the supported keyboard types.

Table 3. Default Key Functions for a 3270 Layout

Function of Key Key

APL Ctrl+F8

Attention Esc

Alternate Cursor Alt+F11

Backspace �─ (Backspace)

Back Tab Shift+─�|

Back Tab Word Alt+←

Break Break

Change Format Toggle Alt+F3

Change Screen Ctrl+PageUp

Clear Pause

Color Blue Ctrl+Shift+F5

Color Field Inherit Ctrl+Shift+F8

Color Green Ctrl+Shift+F3

Color Pink Ctrl+Shift+F2

Color Red Ctrl+Shift+F1

Color Turquoise Ctrl+Shift+F6

Color White Ctrl+Shift+F7

Color Yellow Ctrl+Shift+F4

Cursor Blink Ctrl+F10

Cursor Down ↓ or 2(pad)

Cursor Left ← or 4(pad)
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Table 3. Default Key Functions for a 3270 Layout (continued)

Function of Key Key

Cursor Right → or 6(pad)

Cursor Select Ctrl+F9

Cursor Up ↑ or 8(pad)

Delete Character Delete or
.(pad)

Delete Word Ctrl+Delete or
Ctrl+.(pad)

Document Mode Toggle Alt+F1

Dup Shift+Insert²

Edit Copy Ctrl+Insert

Edit Cut Shift+Delete

Edit Paste Shift+PageDown or
Ctrl+Shift+Insert

Edit Undo Alt+�─ (Backspace)

End Field Pad End

Enter/Control Shift+Ctrl

Erase EOF End²

Erase Field Shift+End²

Erase Input Alt+End²

Fast Cursor Down Alt+↓ or
Alt+2(pad)

Fast Cursor Up Alt+↑ or
Alt+8(pad)

Field Mark Shift+Home²

Graphic Cursor Alt+F12

Highlighting Field Inherit Alt+3(pad)

Highlighting Reverse Alt+*(pad)

Highlighting Underscore Alt+6(pad)

Home Home or 7(pad)

Insert Insert or 0(pad)

Jump Next Alt+PageUp

Mark Down Shift+↓

Mark Left Shift+←

Mark Right Shift+→

Mark Up Shift+↑

Move Mark Down Ctrl+↓ or
Ctrl+2(pad)

Move Mark Left Ctrl+← or
Ctrl+4(pad)

Move Mark Right Ctrl+→ or
Ctrl+6(pad)

Move Mark Up Ctrl+↑ or
Ctrl+8(pad)
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Table 3. Default Key Functions for a 3270 Layout (continued)

Function of Key Key

PA1 Alt+Insert²

PA2 Alt+Home²

PA3 Shift+PageUp²

Pause Ctrl+F7

PF1 to PF12 F1 to F12

PF13 to PF24 Shift+F1 to F12

Play Ctrl+F6

PS Field Inherit Ctrl+Shift+(pad)0

Print (Local Copy) Not assigned

Quit (Device Cancel) Alt+Left Ctrl

Record Ctrl+F5

Reset/Control Left Ctrl

Response Time Monitor Ctrl+F11

Rule Ctrl+Home

Sys Request Shift+Esc

Tab Field ─�| or Shift+─�|(pad)

Tab Word Alt+→

Test Ctrl+PageDown

Transparency Field Inherit Ctrl+Shift+8(pad)

Transparency Opaque Ctrl+Shift+/(pad)

Word Wrap Toggle Alt+F2

Note:
² Indicates the key on the main keyboard.
(pad) Indicates a key on the numeric keypad.

Note: The Enhanced keyboard has some duplicated keys. The functions
of the duplicated keys are the same except when you specify a single
key. For example, Del means any Delete key, whereas Pad Del specifies
only the Delete key on the numeric keypad.

Default Key Functions for the Combined Package
Table 4 shows the default key functions for the combined package. The key used is
the same for all the supported keyboard types.

When you use the 3270+5250 keyboard layout, the key definitions for the 3270 and
5250 layouts are combined with those listed here.

Table 4. Default Key Functions for the Combined Package

Function of Key Key

Change Screen Not assigned

Character Advance Shift+BackSpace

Help Not assigned

Host Print Not assigned

PA3 Not assigned
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Table 4. Default Key Functions for the Combined Package (continued)

Function of Key Key

Roll Down PageUp

Roll Up PageDown

Printer Setup Not assigned

Keyboard Setup

You can use Keyboard Setup to modify the function defined for each key on the
keyboard, except some reserved keys.

You can define the following functions for the keys.
v Performing a key function
v Playing a macro
v Entering characters

Keyboard File

When you specify a key, you can save the new keyboard layout in a file (.KMP). If
you create two or more keyboard files, you can alternate between them as
required.

To assign a function to a key on the keyboard:
1. Select Preferences → Keyboard from the Edit menu
2. When the Keyboard Setup window appears, select Customize.

Note
Select Spain from the Language menu during keyboard setup if you want
Catalan support.

3. Assign the key functions, referring to the online help for detailed instructions.
4. Save your changes and exit the Customize Keyboard window.
5. Click OK after completing the setup.

You can reset either the entire keyboard or specific keys to defaults:
v To reset the entire keyboard, set the current keyboard to IBM Default in the

Keyboard Setup window.
v To reset specific keys, select a key in the Customize Keyboard window and then

select Default from the Current Actions for Selected Key box.

Note
There are seven keys that you cannot redefine and they are gray or dimmed
in Keyboard Setup; these keys are: Alt, AltGr, Print Screen, Scroll Lock,
CapsLock, NumLock, and Shift.

Win32 Cut, Copy, and Paste Hotkeys
Personal Communications 5.6 includes a .KMP keyboard map files that map the
standard Win32 hotkeys for Cut, Copy, and Paste to Ctrl+X, Ctrl+C and Ctrl+V,
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respectively. The key values for the following functions have also been changed:
Page Up, Page Down, Enter, and New Line. The user may utilize the new
keyboard map files or may add these new key values to an existing map file.

For 3270 sessions, the default .KMP file is pcswinkb3.kmp. The remapping is given
in the following table.

Table 5. New Keyboard Map Functions for a 3270 Layout

Function of Key Key

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Page Up PF7

Page Down PF8

Enter Enter

New Line Right Ctrl

Usage Notes for Sessions in OLE Documents

Changing Fonts
If you are using an In-Place embedded session, then changing the font face name,
switching between automatic sizing and fixed size, or changing the size for a fixed
size font can result in an incorrect display on the screen. To correct the display,
adjust the size of the session object window slightly.

Initial Selection of Font
The initial font selection for a embedded or linked session is determined by its
Session ID (a letter A – Z) just like a regular session. Therefore, the initial font may
change if other sessions are already active. Further, to prevent In-Place embedded
sessions from having adverse effects on subsequent sessions, font changes made
during use of In-Place embedded sessions are not saved.

WordPad
Personal Communications session objects created in Microsoft WordPad documents
by the drag-and-drop method cannot be used after the document has been saved
and closed. This limitation may be fixed by some future version of WordPad. For
the present, you should only create Personal Communications objects in WordPad
by using the Insert-Object menu item.

Some versions of Microsoft Word and Microsoft WordPad incorrectly save the state
of embedded objects that are displayed as icons. If you open a document that
contains a Personal Communications session object that was created to display as
an icon, and the object is activated, then it may activate In-Place instead of as a
separate window. This problem may be fixed in future versions of these containers.

WordPro
If you attempt to open a link to a Personal Communications session in a Lotus®

WordPro document, current versions of WordPro may give unpredictable results.
This limitation may be fixed by some future version of WordPro. For the present,
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you should only use embedded Personal Communications objects in WordPro
documents. You can use the “Display as Icon” option if a separate window is
desired.

Updating Linked Files
Files that are linked into Word 97 or Excel 97 do not update automatically. You
must manually save the linked file before your edits are reflected in the container
window.

Inactivity Timeout for Communication Links
The Inactivity Timeout automatically disconnects a link after it has been idle for a
specified length of time. Its purpose is to avoid excessive charges on dial-up links,
such as switched-line connections with SNA/A, Asynchronous IIN, Hayes
AutoSync, or SDLC. Inactivity Timeout is not recommended for other types of
connections.

To enable Inactivity Timeout, add the following statement to the PU section of
your workstation profile (.WS file):

[PU]
InactiveTimeout=xx

The value xx, in the range 1 to 999, is the number of minutes a link remains
connected when there is no activity over it. The default value, InactiveTimeout=0
disables Inactivity Timeout.

Note: The Inactivity Timeout function monitors only attention keys (that is, the
Enter, Clear, and PFx keys). It is recommended that you set a comparably longer
value for xx if, for example, you expect to key in large amounts of data on the
screen before pressing the Enter key.

Considerations
The following are environmental considerations for Personal Communications.

Virtual Memory
If you receive a message stating that the system is low on virtual memory, increase
the virtual memory paging file. If you get this message as you are trying to open
new host sessions or starting a Personal Communications function such as File
Transfer, it is apparent that virtual memory settings should be increased. Refer the
operating system documentation for instructions on how to increase the size of the
paging file.

Emulator Session Icons
Emulator session icons that were not migrated during installation of Personal
Communications Version 5.6 will not function correctly if they were not created in
the application data directory specified during installation of Version 5.6. The icons
can be updated by using the File → Import option from the Session Manager. This
option will not copy the prior icons to the application data directory specified
during installation; the icons must be moved manually

Disabling CDRA Tables
This release uses the standard IBM CDRA translation tables when converting
between ASCII and EBCDIC. From some code page pairs, the standard tables differ
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from those that Personal Communications has used in the past. For code pages
that were supported in prior releases, you can configure Personal Communications
to use the old tables. A switch is available in PCSWIN.INI to disable the use of
CDRA tables. This switch is located in the Translate section and is named
UseOnlyPCOMM. This switch takes a binary value and is defaulted to FALSE
(except for Japan, Korea, Taiwan, and PRC where it defaults to TRUE). For the
code pages that are new to Version 5.6, you must use the standard tables. Setting
the switch will apply to all sessions, as well as data transfer and command line file
transfer.
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Chapter 4. Transferring Files

Personal Communications File Transfer enables you to transfer one or more files
between a host system and workstation at the same time. Transfer types and
translation tables can be defined in advance.

Host Requirements
For PC/3270 File Transfer in SBCS mode, you need one or more of the
following host file-transfer programs (referred to as IND$FILE):
v IBM 3270-PC File Transfer Program, 5665-311 (MVS/TSO)
v IBM 3270-PC File Transfer Program, 5664-281 (VM/SP 2.1)
v IBM CICS/VS 3270-PC File Transfer Program, 5798-DQH (CICS/VS 1.5)

For PC/3270 File Transfer in DBCS mode, you need one or more of the
following host file-transfer programs (referred to as APVUFILE):
v VM/CMS File Transfer Program, 5799-BWK (Japan)
v VM/CMS File Transfer Program, 5799-PGX (Korea, China, Taiwan)
v MVS/TSO File Transfer Program, 5799-BWJ (Japan)
v MVS/TSO File Transfer Program, 5799-PGY (Korea, China, Taiwan)
v CICS (MVS, VSE) File Transfer Program, 5799-BWL (Japan)
v CICS (MVS, VSE) File Transfer Program, 5799-PGZ (Korea, China, Taiwan)

Note:
PCT400 was withdrawn from marketing 3/98.

You can perform the following file transfer functions:
v Send files to the host system
v Receive files from the host system
v Use lists of files
v Create templates to define file names and transfer types
v Define transfer types
v Set transfer options
v Modify translation tables
v Import or export files (PC/3270 CICS only)
v Create interactive document profile (IDP) files (PC/3270 CICS only)
v Transfer files via the XMODEM or YMODEM protocols

Sending Files to the Host System
To send a file from your workstation to the host system:
1. Sign on to the host system.
2. Click Send File to Host from the Actions menu of the session window. (You

can also select the Send button on the tool bar.)
The Send File to Host window appears.

3. Specify the name of the workstation file to be sent to the host system by
entering the name in the PC File text box, or click the Browse button to open a
dialog box for selecting the file.
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4. Enter the name under which the file will be stored on the host; then enter or
select the Transfer Type. If a template is provided for the file type you are
transferring, the host file name and the transfer type appear automatically.

Using List Files
Select Open List; then select the list to be used for transfer. See “Creating
List Files” on page 37 for details of how to create list files.

5. Click Send.
The file is sent to the host system. The send status appears in the Send a File
Status window.

Receiving Files from the Host System
To transfer a file from the host system to your workstation:
1. Sign on to the host system.
2. Click Receive File from Host from the Actions menu. (You can also select the

Receive button from the tool bar.)
The Receive File from Host window appears.

3. Specify the name of the host file to be received. Enter the name in the Host File
text box, or specify it as follows:

Using the Clipboard button
If you have copied one or more host file names to the clipboard, you can
paste the names into the transfer list; click the Clipboard button to open a
dialog box for this. Select one or more of the pasted file names to be
transferred. Then click OK.

4. Enter or modify the suggested name under which the file will be stored on the
workstation, and enter or select the Transfer Type; or click the Browse button
to open a dialog box for selecting a location for the file.

Using List Files
Select Open List, and select the list to be used for transfer. (See “Creating
List Files” on page 37 for an explanation of how to create list files.)

If a template is provided for the file type you are transferring, the workstation
file name and the generated transfer type appear automatically.

5. Click Receive.
The receive status appears in the Receive a File Status window.

Using List Files
If the same files are transmitted frequently, you can create a list of the files and
save it.

A list file can be used for both Send and Receive. The default list file extension is
.SRL.
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Creating List Files
To create a list file:
1. Select Receive File from Host from the Actions menu or Send File to Host

from the Actions menu of the session window; or click the Send or Receive
buttons on the tool bar.
The corresponding window appears.

2. Select a file to be transferred from the Host-File Name or PC-File Name list
box by pointing to the name of a file to be selected. While holding down the
Ctrl key, click the left mouse button.
The file name, its corresponding workstation or host file name (according to the
available templates), and the transfer type appear in the Transfer List part of
the window.

Note: You can also click the Browse button (for sending files) or the Clipboard
button (for receiving files) to open the corresponding dialog box, which
allows you to select files for transferring; when you click OK, the
selected files are shown in the Transfer List.

3. Click the Add to List button to include a selected file in the Transfer List.
4. After all desired files have been selected, click Save List.

The Save File-Transfer List File As window appears.
5. Enter or select a list name, and click OK.

Editing Lists
To edit the contents of a previously created list:
1. As explained in “Sending Files to the Host System” on page 35 and “Receiving

Files from the Host System” on page 36, display the Send File to Host or
Receive File from Host window.

2. Select Open List.
The Open File-Transfer List File window appears.

3. Select the name corresponding to the list file to be edited, then click OK.
4. The contents of the selected list appear in the Send File to Host or Receive File

from Host window.
5. Edit the contents of the list file.

Changing the contents of a list
Choose the file to be changed from the list, and overwrite the items to be
changed in the text box; then click the Update in List button.

Removing a file from the list
Choose the file to be removed, and click Remove from List.

Adding a file to the list
Double-click the file to be added from the list of host or workstation files.

6. Select Save List.
The Save File-Transfer List File As window appears.
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7. Enter a name and then click OK.

Managing Templates
A template is a set of rules to be used by the workstation to automatically generate
a workstation or host file name and transfer type when you specify a file to be
sent or received.

You can have up to 32 templates. They are automatically numbered from 1 to 32.

When you specify a file to be transferred, the workstation scans the templates,
starting from template 1. It uses the first matching template to generate a name for
the transferred file and the transfer type.

To manage a template:
1. Click Receive File from Host from the Actions menu or Send File to Host

from the Actions menu of the session window; or click the Send or Receive
buttons on the tool bar.
The Send File to Host or Receive File from Host window appears.

2. Select Template.
The Template window appears. The contents of the window depend on the
connected host system.

Adding Templates
The list box for the Template window lists the currently stored templates.

To add a template:
1. Select any template from the list box.

The contents of the selected template appear under the list box.
2. Change the workstation or host file names or extensions by overwriting them;

then select the transfer type. (For details of the transfer types, see “Defining
Transfer Types” on page 39.)

3. Click Add.
The window for determining where in the list to display the new template
appears.

4. Select a template number and specify whether to display the new template
before or after the template that has that number. Click OK.
The new template is added to the list in the appropriate position.

Replacing and Deleting Templates
To change the contents of a currently stored template, or to delete a template:
1. Select the template to be changed or deleted.

The contents of the selected template appear under the list box.
2. To change the contents, overwrite the appropriate part and then click Replace.

To delete a template, click Delete.
The selected template is changed or deleted, and the contents of the template
list box are changed.
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Testing Templates
To test the contents of an added or changed template:
1. Select the template to be tested from the list box.

The number of the selected template appears in the Test Templates box in the
lower part of the window.

2. Select or enter data for the following items:

Test Mode
Determine which mode is to be used for the test: the mode in which a
file is transmitted from the workstation to the host system (send), or
the mode in which a file is transmitted from the host system to the
workstation (receive).

Templates
Determine which templates to test: only the template selected in step 1,
or all registered templates.

Source File
Enter the name of the file to be used for the test.

3. Click Test.
Target File indicates the name that has been generated by the template.

Note: Testing a template does not transfer a file.

Defining Transfer Types
Transfer types define the option information used for controlling file transfer. Up
to 32 transfer types can be defined for each host system. Text, binary, and append
(excluding CICS) are the defaults.

To add or change transfer types:
1. Click Edit → Preferences → Transfer from the session window.
2. Click the tab for your host type or modem protocol.

The property page for the selected host or modem protocol appears. The items
that appear depend on the selected host system.

3. Enter transfer-type names in the Transfer Type box, or select them from the
drop-down list.

4. Select or enter the required items (see “Items to Be Specified”).
To add or replace a transfer type, click Save. To delete a transfer type, click
Delete.

5. A dialog box displays, asking for confirmation. Click OK.

Items to Be Specified
Choosing the appropriate property page enables you to set the items described in
the following sections.

File Options
The file options that can be used depend on the type of the connected host system
and the host code page selected when the session was configured. Table 6 on
page 40 lists the mode values for the file transfer options. Table 7 on page 40 lists
the transfer options.
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Table 6. Mode Values for File Transfer Options

Mode Host Code Page

DBCS 930 (Japan Katakana)
930 (Japan Katakana - Extended)
939 (Japan Latin - Extended)
1390 (New Japanese Katakana - Extended)
1399 (New Japanese Latin - Extended)
933 (Hangeul)
1364 (Hangeul 1364)
935 (Simplified Chinese)
937 (Traditional Chinese)
1371 (Taiwan 1372)

SBCS Others

Table 7 lists the options for PC/3270.

Table 7. Transfer File Options

File Option Host
System

Mode Conversion Details

ASCII VM/CMS
MVS/TSO
ICS

SBCS
DBCS

Converts codes as follows when a file is sent:

v Converts 1-byte workstation codes to EBCDIC
codes

v Converts 2-byte workstation codes to IBM host
DBCS codes

v Adds SO (hex 0E) and SI (hex 0F) before and
after the DBCS field

v Converts RS (hex 1E) and US (hex 1F) to SO
(hex 0E) and SI (hex 0F)

Converts codes as follows when a file is received:

v Converts EBCDIC codes to 1-byte workstation
codes

v Converts IBM host DBCS codes to 2-byte
workstation codes

v Removes SO (hex 0E) and SI (hex 0F) from
before and after a DBCS field

JISCII VM/CMS
MVS/TSO
CICS

DBCS Converts codes as follows when a file is sent:

v Converts 1-byte workstation codes to EBCDIC
codes

v Converts 2-byte workstation codes to IBM kanji
codes

v Adds SO (hex 0E) and SI (hex 0F) before and
after the kanji field

v Converts RS (hex 1E) and US (hex 1F) to SO
(hex 0E) and SI (hex 0F)

Converts codes as follows when a file is received:

v Converts EBCDIC codes to 1-byte workstation
codes

v Converts IBM kanji codes to 2-byte workstation
codes

v Removes SO (hex 0E) and SI (hex 0F) from
before and after a kanji field
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Table 7. Transfer File Options (continued)

File Option Host
System

Mode Conversion Details

CRLF VM CMS
MVS/TSO
CICS

SBCS
DBCS

Converts codes as follows when a file is sent:
v Does not remove CRLF (hex 0D0A) from the

end of each line. The code is treated as a
delimiter for each record.

v Removes EOF (hex 1A) from the end of the file.

Converts codes as follows when a file is received:
v Adds CRLF (hex 0D0A) to the end of each line.
v Adds EOF (hex 1A) to the end of the file.

Removes EOF from the existing file, and
appends EOF to the end of the added file when
APPEND is specified.

APPEND VM/CMS
MVS/TSO

SBCS
DBCS

Appends the sent file to the existing host file.
Appends the received file to the existing
workstation file.

SO VM/CMS
MVS/TSO
CICS

DBCS This option is valid only for DBCS when used
with the JISCII and ASCII options when receiving
a file. SO (hex 0E) and SI (hex 0F) are converted
to RS (hex 1E) and US (hex 1F).

NOSO VM/CMS
MVS/TSO
CICS

DBCS This option is valid only for DBCS when used
with the JISCII and ASCII options when sending
a file.
v SO (hex 0E) and SI (hex 0F) are not added

before and after the DBCS field.
v RS (hex 1E) and US (hex 1F) are not converted

to SO (hex 1F) and SI (hex 0F).

BLANK VM/CMS
MVS/TSO
CICS

DBCS This option is valid with the CRLF option when
receiving a file. BLANK (hex 40) is not removed
from the end of each line.

USER VM/CMS
MVS/TSO
CICS

DBCS This option is valid only for DBCS when used
with the JISCII, ASCII, and SO options when
receiving a file. SO (hex 0E) and SI (hex 0F) are
not converted to RS (hex 1E) and US (hex 1F);
they are written to a file without being converted.

Record Format
Valid only for VM/CMS and MVS/TSO when APPEND is not specified for file
transmission. You can select any of the following:
v Default
v Fixed (fixed length)
v Variable (variable length)
v Undefined (undefined mode for MVS/TSO only)

If you select the Default value, the record format is selected automatically by the
host system.

Specifying Variable for VM file transfer enables host disk space to be used
efficiently.

Logical Record Length (LRECL)
Valid only for VM/CMS and MVS/TSO when APPEND is not specified for file
transmission.
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Enter the logical record length to be used (host record byte count) in the LRECL
text box. If Variable and Undefined Mode are specified as the record format, the
logical record length is the maximum record length within a file. The maximum
value is 32767.

The record length of a file sent from a workstation to the host system might exceed
the logical record length specified here. If so, the host file transfer program divides
the file by the logical record length.

When sending a text file from a workstation to a host, if the text file contains
2-byte workstation codes (such as kanji codes), the record length of the file is
changed because SO and SI have been inserted.

To send a file containing long records to the host system, specify a sufficiently long
logical record length.

Because the record length of a workstation file exceeds the logical record length, a
message does not appear normally if each record is divided. To display a message,
add the following specification to the [Transfer] item of the workstation profile:
DisplayTruncateMessage = Y

TSO Allocation Parameter (MVS/TSO)
Valid only for MVS/TSO when APPEND is not specified for file transmission. The
following items can be specified:

[Allocation Amounts]

Primary
Enter the number of tracks or cylinders allocated to this file transfer.

Secondary
If the primary allocation is not sufficient for the entire file transfer, enter
additional storage capacity allocated to the file transfer.

[Allocation Units]

Tracks
Specify this parameter to allocate a host file by track. Ask your system
manager whether to use tracks or cylinders as the unit.

Cylinders
Specify this parameter to allocate a host file in units of cylinders.

AVblocks
Specify this parameter to allocate a host file in units of blocks.

[Block size]

This item is used only to create a new data set. Enter the block size of a new host
data set, in bytes, in the text box. If this item is omitted, the workstation assumes
the value that appears in the Logical Record Length box. The maximum value is
32767. If AVblocks is selected, the block size is the block size of the new data set.

Additional Options
You can enter the required host command options in the Additional Options text
box.
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Setting General Transfer Options
To set advanced options:
1. Click Edit → Preferences → Transfer from the session window.

The setup dialog is displayed.
2. Change the required settings on the property page labeled General.
3. Click OK.

The following sections contain information about the items which can be defined
for file transfer options.

Host Type
You can specify from the drop-down list box the type of host (MVS/TSO, VM, or
CICS) to which your workstation is connected.

Host Command
You can specify host command to be called when file transfer starts. If nothing is
entered in this text box, IND$FILE or its equivalent for other countries is used for
3270 SBCS and DBCS sessions.

Default PC Directory
You can specify the default directory that appears in the Send File to Host or
Receive File From Host window. To select the directory, click the Browse button.

Default Partitioned Data Set (MVS/TSO Only)
You can specify the MVS partitioned data set to be used as the default.

Default VM Disk (VM Only)
You can specify the VM disk to be used as the default.

PC Code Page
When a file is transferred, EBCDIC codes are converted to 1-byte workstation
codes, and vice versa. A valid value is automatically selected from among the
following values for SBCS sessions: 437, 737, 806, 813, 819, 833, 850, 852, 854, 857,
858, 860, 861, 862, 863, 864, 865, 866, 869, 874, 912, 915, 916, 920, 921, 922, 1008,
1089, 1124, 1125, 1127, 1129, 1131, 1133, 1153, 1155, 1156, 1157, 1158, 1160, 1164, 1250,
1251, 1252, 1253, 1254, 1255, 1256, 1257, and 1258; and from the following values
for DBCS sessions: 897 and 1041 (Japanese); 1088 and 1126 (Hangeul); 1114
(Simplified Chinese and Traditional Chinese)—according to the host code page
specified when the workstation is configured. For an explanation of how to select
host code pages, see the online help for the host code page.

Packet Size
The amount of memory (in bytes) used by the workstation for transmission and
reception. If a large value is entered, a file is transferred more quickly, but the
memory overhead is larger. The default value is 12288. In the case of Telnet3270,
you can specify a packet size larger than 8000 bytes by adding the following line
to the Telnet3270 stanza in your workstation profile:
SendBufferSize=nnnn
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File-Transfer Timeout
You can define the time the workstation waits for a response from the host system
(in seconds). If the host system does not respond, the transfer is canceled, and an
error message appears. A number in the range 20–65535 (or 0) can be specified.
The default is 60 seconds for ASCII sessions; for all others, it is 30 seconds. Specify
an appropriate value such that the error message does not appear too early. If you
specify 0, a timeout is not set.

If a packet or block size is relatively large for low-speed lines, such as SDLC or
COM port lines, it is recommended that 150 seconds or greater be specified.

Extension for List-Files
You can change the default extension (.SRL) of file-transfer list files.

Clear Session Before Transfer
You can specify whether a Clear command is sent to the host system before a file
is transferred. Choose any of these option buttons:

Default
A Clear command is sent before a file is transferred (VM/CMS or CICS
only).

Yes A Clear command is sent for MVS also.

No A Clear command is not sent for any host system.

Show Status Window
You can choose the method of displaying the file-transfer-progress status.

In Session
When file transfer starts, the status window appears. The name of the file
being transferred and the transfer progress appear.

In icon
When file transfer starts, the status icon appears on the screen. If the icon
is restored, the status window appears.

Enhanced Protocol (SBCS Global Network Connection Only)
This option enables faster file transfer in most cases. The packet size for Enhanced
Protocol is fixed, so the File Transfer Packet Size setting is ignored.

Lam-Alef Expansion (Arabic Only)
If you want the Lam-Alef characters transferred from the host to be expanded into
the two-character representation for Windows, click this check box.

Note: This will change the size of the record on the personal computer; this should
not be a problem for normal text files, but exercise caution when formatted
files and databases are being transferred.

Setting Up the Translation Table
You can create or edit the translation table to be used for sending or receiving files.
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When you use a DBCS session as the host session, that is, when 930 or 939
(Japanese), 933 or 1364 (Hangeul), 935 (Simplified Chinese), or 937 (Traditional
Chinese) is specified during configuration as the host code page, you can create
and change a translation table for the user-font area. A DBCS translation table is
then used for displaying a screen, printing, and sending and receiving files.

Changing the Translation Table
To change the translation table:
1. Click Edit → Preferences → Transfer from the session window.
2. Click the Translation Table tab on the resulting window.

The Translation-Table Setup property page appears.
3. The table currently being used (IBM default or the name of a user-defined

table) is shown. Choose either IBM Default or User-Defined.
4. If you choose User-Defined, enter a translation-table name in the File Name

text box, or select a name by clicking Browse.
5. Click OK.

Customizing the Translation Table
You can create a user-specific translation table for transmission or reception, or you
can edit an existing translation table.

To create or edit a translation table:
1. On the Translation Tables property page, click Customize in the Upload or

Download window.
The Customize Translation window appears.
If you chose IBM Default or if you chose New from the File menu, the default
values appear in the table.

Translation source codes
PC code-points when an upload translation table is edited. Host
code-points when a download translation table is edited.

Translation target codes
Host code-points when an upload translation table is edited. PC
code-points when a download translation table is edited.

2. Double-click the code to be changed in the table, and change the value in the
entry field that subsequently appears.

3. Click Save or Save As from the File menu.
4. If asked, enter a name in the Save Translation File As window and click OK.
5. Click Exit from the File menu of the Customize Translation window.

User-Font Area (DBCS Only)
For DBCS sessions, the following code ranges can be defined by the user with the
DBCS translation table:

Host kanji code
First byte: from X'69' to X'7F'

Second byte: from X'41' to X'FE'

Workstation kanji code
First byte: from X'F0' to X'F9'

Second byte: from X'40' to X'7E', from X'80' to X'FC'
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Host kanji numbers
The host kanji-numbers area corresponds to the user-font area of host kanji
codes. For example, the host kanji number 10561 corresponds to the host
kanji code 6941.

JIS KUTEN numbers
From section 95 to section 114 (from 1 to 94)

Traditional Chinese host code
From X'C241' to X'E2FD' (low byte X'41' to X'FD', skipping X'7F')

Traditional Chinese workstation code
From X'FA40' to X'FEFE' (low byte X'40' to X'7E', X'A1' to X'FE')
From X'8E40' to X'A0FE' (low byte X'40' to X'7E', X'A1' to X'FE')
From X'8140' to X'8DFE' (low byte X'40' to X'7E', X'A1' to X'FE')
From X'8181' to X'8C82' (low byte X'81' to X'A0')
From X'F9D6' to X'F9FE'

Simplified Chinese host code
From X'7641' to X'7FFD' (low byte X'41' to X'FD', skipping X'7F')

Simplified Chinese workstation code
From X'8DA1' to X'A0FE' (low byte X'A1' to X'FE')

Hangeul host code
From X'D441' to X'DDFD' (low byte X'41' to X'FD', skipping X'7F')

Hangeul workstation code
From X'C9A1' to X'C9FE' (low byte X'A1' to X'FE')
From X'FEA1' to X'FEFE' (low byte X'A1' to X'FE')
From X'8FA1' to X'A0FE' (low byte X'A1' to X'FE')

Import/Export (3270 CICS Only)
Import/Export is an office system communication program and an application
program executed under the IBM Customer Information Control System (CICS).

Clicking Import/Export loads a module into workstation memory. You can then
start Import or Export from a menu on the host screen.

When you export a document from the host, the workstation receives two files: one
is the file itself, and the other is the interchange document profile (IDP) file, which
contains document header information.

When you Import a file to a host system, it must be accompanied by an IDP file of
the same name. If the necessary IDP file does not exist, you can create it as
described in “Creating IDP Files” on page 47.

To transmit files using Import/Export:
1. Verify that the window of the host session is active and ready for file transfer.
2. Click Import/Export from the Actions menu of the session window.

The minimized Import/Export Status window appears.
3. Click Import or Export from the host application menu.
4. Specify the host and workstation file names of the file to be transferred. Run

Import or Export.
When Import or Export starts, the Import/Export Status window is maximized.
After the file is transferred, the window is closed.
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Creating IDP Files
To send a document to the host system using Import, you must have an IDP file
that includes information on the document. If you have previously exported the
file, you should have an IDP. If not, or if you have deleted the IDP file, you must
create an IDP file.

To create an IDP file:
1. Click Edit → Preferences → Transfer from the session window.
2. Click the IDP Files tab on the setup window.
3. Enter the name for the IDP file to be created, or click Browse to select it.

The IDP file has the same name as the file to be transferred, and the extension
(.IDP).

4. Click OK.

File Transfer Commands for PC/3270
You can send data files to and receive them from IBM host systems that are
running:

CICS/MVS
Customer Information Control System running under MVS

CICS/VSE
CICS running under Virtual Storage Extended

MVS/TSO
Multiple Virtual Storage/Time Sharing Option

OV/MVS
OfficeVision/MVS

VM/CMS
Virtual Machine/Conversational Monitor System

For more information on using these commands, click Send File to Host from the
Actions menu and File Transfer from Command prompt in the help panel.

File Transfer Methods
You can transfer files in the following ways with PC/3270:
v By clicking Receive File from Host from the Actions menu or Send File to Host

from the Actions menu of the workstation window
v By using the SEND and RECEIVE commands at the DOS command prompt
v By using an EHLLAPI application that invokes file transfer
v By using a macro that has send or receive commands as macro statements
v By clicking the Send or Recv icon on the tool bar

Requirements and Restrictions
Install the file transfer program, IND$FILE, on your host system. Ask your system
administrator for additional file transfer procedures and precautions. An alternate
host command name can be used by defining a DOS environment variable
IND_FILE in AUTOEXEC.BAT or in a particular DOS box. For example:

SET IND_FILE = MYXFER

Similarly, for DBCS sessions, you can define a DOS environment variable
IND_FILE in AUTOEXEC.BAT or in a particular DOS box. For example:

Chapter 4. Transferring Files 47



SET IND_FILE = MYXFER

You should not use the following words as a VM file name or file type, as an MVS
data set name, or as a CICS file name, because they are reserved for use as option
commands.

ASCII, APPEND, TIME, CLEAR, NOCLEAR, SILENT, QUIET, PROGRESS,
JISCII, SO, NOSO, BLANK, USER, CRLF, BINARY, NOCRLF

If you want to send to or receive from a subdirectory other than \Personal
Communications, you must specify the full path name.

Sending and Receiving Files from the DOS Command Prompt
The workstation is the point of reference for the SEND and RECEIVE commands:
You send from the workstation to the host and receive from the host to the
workstation.

To send or receive a file:
1. Make sure you are logged on to your host.
2. Make sure the Ready message of the host system is displayed, except if you are

transferring files through the command option of the ISPF application.

Note: In the latter case, you must specify the NOCLEAR option for the file
transfer command.

If your screen is blank, make sure that no applications are running and that
your host session is not in a holding state.

Note: If you receive any messages from host application programs while you
are transferring files, the transfer might not succeed. To prevent
messages from interfering, enter the appropriate host command to set
messages off temporarily. When file transfer is finished, set messages on
again.

3. Switch to your DOS window session or DOS full-screen session.
4. If you use a hard disk, make sure the SEND.EXE and RECEIVE.EXE files are in

your current directory or in your path. If you want to send to or receive from a
subdirectory other than \Personal Communications, you must specify the full
path name.

5. Type the appropriate SEND or RECEIVE command at the DOS command
prompt.
Details on the SEND and RECEIVE commands and their options are explained
in the following sections.

Using the VM/CMS SEND Command
Use the following information when sending a file to VM/CMS:

Figure 1 on page 49 shows the command and information that you must provide.
Enter it as shown (including parentheses). You can use either uppercase or
lowercase letters.

Notes:

1. � means to insert a space. There must not be a space between h: and fn.
2. For DBCS sessions, insert a left bracket ([) before (options.
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�A� The workstation drive and path of the file to send.

�B� The name of the workstation file to send.

�C� Host session specifications for the file to be sent to the host.
h: The short name of the session (which can be omitted if it is a)
fn File name
ft File type
fm File mode

�D� Optional changes made to the file during transfer. More than one option
can be selected. Valid options are:
v APPEND
v ASCII
v CLEAR
v CRLF
v JISCII (for Japanese DBCS sessions)
v LRECL n
v NOCLEAR
v NOSO
v PROGRESS
v QUIET
v RECFM x
v TIME(n)

The parts of the VM/CMS SEND command are:

SEND The command.

d: The name of the diskette or hard disk drive on which the file is located.

path The path to the subdirectory that the file is in.

filename.ext
The name of the file to be sent, including the extension.

h: The short name of the host session to which you want to send the file. The
default is a:.

fn ft fm
The name the file is to have on your VM/CMS disk. You must specify the
file name (fn) and file type (ft). You can omit file mode (fm) if you want
the file placed on your A-disk. You can create a new name or use a name
that is already on your disk. If you use a new name, the file that you send
is added to your disk. If you use the name of an existing file, the file that
you send either replaces or is added to the old file. (Refer to the
description of the APPEND option.)

(options or [(options (for DBCS)
These options can be specified:

APPEND
Specifies that the file being sent is to be added to the end of an
existing VM/CMS file. Omit this option if you want the file to

Figure 1. VM/CMS SEND Command Syntax
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replace an existing file. You cannot specify the LRECL n or RECFM
x option if you use the APPEND option.

ASCII Performs the following:
v Converts 1-byte workstation codes to EBCDIC codes.
v Converts 2-byte codes to IBM host DBCS codes.
v Inserts SO/SI characters into the DBCS field and, if control

characters (→ or ←) are found, converts the control characters to
SO/SI characters.

CLEAR
Clears the workstation window at the beginning of the file transfer.
CLEAR is the default.

CRLF Specifies preserving of the carriage return and line feed codes. You
need the ASCII and CRLF options for text or source files that you
want to view or edit, such as SCRIPT files. You do not need them
for binary files, such as programs.

JISCII This option is valid for Japanese DBCS sessions only and performs
the following:
v Converts 1-byte workstation codes to EBCDIC codes.
v Converts 2-byte codes to IBM kanji codes.
v Inserts SO/SI characters into the DBCS field and, if control

characters (→ or ←) are found, converts the control characters to
SO/SI characters.

LRECL n
Specifies the file’s record length. Include a record length only if
you want the file to have a record length on your VM/CMS disk
other than 80. Replace n with the record length you want. If you
omit this option, the record length is set to 80 for fixed-length
records or to a maximum of 80 for variable-length records.

NOCLEAR
Suppresses the sending of a Clear command at the beginning of
the file transfer.

NOSO
This option is valid only for DBCS when used with the JISCII or
ASCII option and performs the following:
v Does not convert SO (hex 0E) and SI (hex 0F) before and after

the DBCS field.
v Does not convert RS (hex 1E) and US (hex 1F) to SO (hex 0E)

and SI (hex 0F).

PROGRESS
Shows a message indicating that the file transfer is in progress or
has ended. Such messages do not show the current transferred
bytes.

QUIET
Does not show any messages.

RECFM x
Specifies the file record format. Use this parameter to specify
variable-length or fixed-length records in the file. Replace x with V
for variable or F for fixed. By default, the file has fixed-length
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records unless you specify the CRLF option; then the file has
variable-length records unless you specify otherwise.

TIME(n)
Specifies the length of time n, in units of 30 seconds, that the
program waits for a response from the host before it sends an error
message. Replace n with an integer value in the range from 0
through 2184. If you specify 0, timeout will not be set. The default
is 1. To avoid a premature error message, specify an adequate
value. In cases of large packet sizes, of large block sizes, or for
slow communication lines (such as SDLC and COM port), 5 (150
seconds) is recommended. There should be no blank spaces is
between TIME and (n).

Command Syntax for Sending Files to VM/CMS: The following examples show
the command syntax you can use to send files to a VM/CMS host. The parameters
of the SEND command can be combined into a single set of parentheses.

Note: For Japanese DBCS sessions, use the JISCII rather than the ASCII option. For
Hangeul, Simplified Chinese, and Traditional Chinese DBCS sessions, use
the ASCII rather than the JISCII option.

v To send a workstation file from your default drive and add it as a new file on
your VM/CMS A-disk:
SEND pc.txt a:cmsfile script a (ASCII CRLF LRECL 72 RECFM V

SEND pc.txt a:cmsfile script a [(JISCII CRLF LRECL 72 RECFM V (for DBCS)

Note: If you use a command that exceeds one line, do not press Enter when you
fill that line; continue typing your command.

This command sends a workstation file named PC.TXT from your default drive
to your host in your host session named a. You do not need to specify the
workstation drive if the file you are sending is on the current drive. The
command creates a new file, named CMSFILE SCRIPT, on your A-disk. The
records in the file can vary in length up to 72 characters.

v To send a workstation file from your default drive to replace a file on your
VM/CMS A-disk:
SEND pc.txt a:cmsfile script a (ASCII CRLF

SEND pc.txt a:cmsfile script a [(JISCII CRLF (for DBCS)

This command sends a workstation file named PC.TXT from your default drive
to your VM/CMS A-disk in your host session named a. You do not need to
name the workstation drive if the file you are sending is on the default drive.
The file replaces a SCRIPT file named CMSFILE. The new CMSFILE has the
same record length and format as the old CMSFILE.

If you do not have a file called CMSFILE SCRIPT on your A-disk, PC.TXT is
added to your A-disk as a new file called CMSFILE SCRIPT. The records in the
file are 80 characters long and have fixed length.

v To send a binary workstation file from a drive other than your default drive:
SEND a:pc.exe c:cmsfile exebin b (recfm v

This command sends a workstation file named PC.EXE from a diskette in drive
A to your VM/CMS B-disk in your host session named c. It is a new file, or it
replaces a file named CMSFILE.
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When transferring a binary file, you must specify a variable record format
(recfm v), otherwise, blank characters are added to the file.

v To send a file from your hard disk and add it to the end of a file on your
VM/CMS A-disk:
SEND c:pc.txt cmsfile script a (ASCII CRLF APPEND

SEND c:pc.txt cmsfile script a [(JISCII CRLF APPEND (for DBCS)

This command sends a workstation file named PC.TXT from your hard disk to
your host session. You do not need to name the host session if you are sending
to the a session. The file is added to the end of a script file named CMSFILE on
your VM/CMS A-disk.

v To send a file from a subdirectory on your hard disk to your VM/CMS A-disk:
SEND c:\sd1\pc.txt cmsfile script a (ASCII CRLF

SEND c:\sd1\pc.txt cmsfile script a [(JISCII CRLF (for DBCS)

This command sends a file named PC.TXT from subdirectory SD1 on your hard
disk to your host session. It replaces a SCRIPT file named CMSFILE on your
VM/CMS A-disk.

Using the VM/CMS RECEIVE Command
Use the following information when receiving a file from VM/CMS:

Figure 2 shows the command and information you must provide. Enter it as shown
(including parentheses), except that you can use either uppercase or lowercase
letters.

Notes:

1. � means to insert a space. There must not be a space between h: and fn.
2. For DBCS sessions, insert a left bracket ([) before (options.

�A� The workstation drive and path of the file to be received.

�B� The name of the workstation file to be received.

�C� Host session specifications for the file to be received from the host.
h: The short name of the session (which can be omitted if it is a)
fn File name
ft File type
fm File mode

�D� Optional changes made to the file during transfer. More than one option
can be selected. Valid options are:
v APPEND
v ASCII
v BLANK
v CLEAR
v CRLF
v JISCII (for Japanese DBCS sessions)

Figure 2. VM/CMS RECEIVE Command Syntax
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v NOCLEAR
v PROGRESS
v QUIET
v SO
v TIME(n)
v USER

The parts of the VM/CMS RECEIVE command are:

RECEIVE
The command.

d: The name of the diskette or hard disk drive on which the file is to be
received.

path The path indicating the directory to which the file is to be stored.

filename.ext
The name of the workstation file, including the extension. Use a new name
or one that already exists. If you use a new name, the file that you receive
is added to your diskette or hard disk. If you use the name of an existing
file, the file that you receive either replaces or supplements the existing
file. (Refer to the APPEND option.)

h: The short name of the host session from which you want to get the file.
The default is a:.

fn ft fm
The name of the file you want to receive from your VM/CMS disk. The
file name fn is required.

(options or [(options (for DBCS)
These options can be specified:

APPEND
Specifies that the file being received is to be added to the end of an
existing file. Omit this part of the VM/CMS file that is received to
replace an existing file.

ASCII Performs the following:
v Converts EBCDIC codes to 1-byte workstation codes.
v Converts IBM host DBCS codes to 2-byte codes.
v Removes SO and SI characters from a DBCS field.

BLANK
This option is valid with the CRLF option. Use it to retain BLANK
(x’40’) at the end of each line.

CRLF Specifies the carriage return and line feed codes. You need ASCII
and CRLF for text or source files that you want to view or edit,
such as SCRIPT files. You do not need them for binary files, such
as programs.

CLEAR
Clears the workstation window at the beginning of the file transfer.

JISCII This option is valid for Japanese DBCS sessions only and performs
the following:
v Converts EBCDIC codes to 1-byte workstation codes.
v Converts IBM kanji codes to 2-byte codes.
v Removes SO and SI characters from a DBCS field.
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NOCLEAR
Suppresses the sending of a Clear command at the beginning of
the file transfer.

PROGRESS
Shows a message indicating that the file transfer is in progress or
has ended. Such messages do not show the current transferred
bytes.

QUIET
Does not show any messages.

SO This option is valid only for DBCS when used with the JISCII or
ASCII option; it converts SO (hex 0E) and SI (hex 0F) to RS (hex
1E) and US (hex 1F).

TIME(n)
Specifies the length of time, in units of 30 seconds, that the
program waits for a response from the host before it sends an error
message. The value n is an integer value in the range from 0
through 2184. If you specify 0, timeout is not set. The default is 1.
To avoid a premature error message, specify an adequate value. In
cases of large packet sizes, of large block sizes, or for slow
communication lines (such as SDLC and COM port), 5 (150
seconds) is recommended. There should be no blank spaces
between TIME and (n).

USER This option is valid only for DBCS with the options JISCII, ASCII,
and SO. SO (hex 0E) and SI (hex 0F) are not converted to RS (hex
1E) and US (hex 1F); they are written to a file without being
converted.

Command Syntax for Receiving Files from VM/CMS: The following examples
show the command syntax you can use to receive files from a VM/CMS host. The
parameters of the RECEIVE command can be combined into a single set of
parentheses.

Note: For Japanese DBCS sessions, use the JISCII rather than the ASCII option. For
Hangeul, Simplified Chinese, and Traditional Chinese DBCS sessions, use
the ASCII rather than the JISCII option.

v To receive a file from your VM/CMS A-disk to your default drive for a
workstationsession:
RECEIVE pc.txt a:cmsfile script a (ASCII CRLF

RECEIVE pc.txt a:cmsfile script a [(JISCII CRLF (for DBCS)

This command sends a SCRIPT file CMSFILE from your VM/CMS A-disk in a
host session named A to your workstation session. It adds the file to your
default drive (diskette or hard disk) with the name PC.TXT.

v To receive a file from your VM/CMS B-disk and replace a file on a drive other
than your default:
RECEIVE a:pc.txt a:cmsfile script b (ASCII CRLF

RECEIVE a:pc.txt a:cmsfile script b [(JISCII CRLF (for DBCS)

This command sends a SCRIPT file named CMSFILE SCRIPT from your
VM/CMS B-disk in a host session named A to a drive other than the default for
your PC session. It replaces a file named PC.TXT on a diskette in drive A.
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v To receive a file from your VM/CMS A-disk and add it to the end of a file on
your hard disk:
RECEIVE c:pc.txt a:cmsfile script a (ASCII CRLF APPEND

RECEIVE c:pc.txt a:cmsfile script a [(JISCII CRLF APPEND (for DBCS)

This command sends a SCRIPT file named CMSFILE SCRIPT from your
VM/CMS A-disk in a host session named A to your workstation session. It adds
the contents of CMSFILE to the end of a file named PC.TXT on your hard disk.

v To receive a file from your VM/CMS A-disk and place it in a subdirectory on
your default drive:
RECEIVE \sd1\pc.txt a:cmsfile script a (ASCII CRLF

RECEIVE \sd1\pc.txt a:cmsfile script a [(JISCII CRLF (for DBCS)

This command sends a SCRIPT file named CMSFILE SCRIPT from your
VM/CMS A-disk to your default drive. It creates or replaces a file named
PC.TXT in a subdirectory named \SD1.

Using the MVS/TSO SEND Command
Use the following information when entering the SEND command to the
MVS/TSO host:

Figure 3 shows the command and information you must provide. Enter text as
shown (including parentheses), except that you can use either uppercase or
lowercase letters.

Notes:

1. � means to insert a space. There must not be a space between h: and fn.
2. For DBCS sessions, insert a left bracket ([) before options.

�A� The workstation drive and path of the file to send.

�B� The name of the workstation file to send.

�C� The short name of the host session and the data set name of the file to
send.

�D� The member name if the file is in a partitioned data set.

�E� The password of the data set if it has one.

�F� Optional changes made to the file during transfer. More than one option
can be specified. Valid options are:
v APPEND
v ASCII
v BLKSIZE(n)
v CLEAR

Figure 3. MVS/TSO SEND Command Syntax
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v CRLF
v JISCII (for Japanese DBCS sessions)
v LRECL(n)
v NOCLEAR

You must use the NOCLEAR option when you are transferring files while
in ISPF command mode on the host.
v NOSO
v PROGRESS
v QUIET
v RECFM(x)
v SPACE(n[,n1]) unit
v TIME(n)

The parts of the MVS/TSO SEND command are:

SEND The command.

d: The name of the diskette or hard disk drive where the file is located.

path The path indicating the directory where the file is located.

filename.ext
The name of the file to be sent. Include the extension if the file has one.

h: The name of the MVS/TSO host session to which you want to send the
file. You can omit this name if you have only one host. If you have more
than one host, this is the short name of the MVS/TSO host session. The
default short name is A.

data-set-name
The data set name that the file you send is to have on your MVS/TSO
volume; this name is required. Enclose the data set name with the member
name in single quotation marks if you are using a fully qualified data set
name.

This option creates a new name or uses a data set name already on your
TSO volume. If you use a new name, the file that you send is added to
your MVS/TSO volume. If you use the name of an existing data set, the
file you send either replaces or supplements the existing data set. Refer to
the APPEND option.

(member-name)
The member name if the file is to be put into a partitioned data set. If you
use member-name, you cannot use LRECL(n), BLKSIZE(n), RECFM(x), and
SPACE(n,[n1]) unit.

Note: If someone else is using the partitioned data set, you cannot send a
file to your MVS/TSO host.

/password
The password of the data set, if the data set has a password.

options or [(options (for DBCS)
These options can be specified:

APPEND
Specifies that the file being sent is added to the end of an existing
MVS/TSO data set. Omit this option if you want the file to replace

56 Personal Communications 3270 Emulator User’s Reference



an existing MVS/TSO data set. You cannot use LRECL(n),
RECFM(x), SPACE(n[,n1]) unit, or BLKSIZE(n) options if you use
the APPEND option.

ASCII Performs the following:
v Converts 1-byte workstation codes to EBCDIC codes.
v Converts 2-byte codes to IBM host DBCS codes.
v Inserts SO and SI characters in the DBCS field.

BLKSIZE(n)
Specifies the size of the blocks of data in a new data set on your
MVS/TSO volume. This part is optional. To set the block size for a
new data set, replace n with the new size. If you omit this option,
the block size is determined in the following manner:
v If the record format is variable, the block size is 6233.
v If the record format is fixed, the block size is the largest multiple

of the record length that is less than 6233:
BLKSIZE = LRECL * (6233/LRECL)

If you use the (member-name) or APPEND option, do not use this
option.

CLEAR
Clears the workstation window at the beginning of the file transfer.

CRLF Specifies the global use of carriage return and line feed codes. You
need to specify ASCII and CRLF options for sending text or source
files that you want to view or edit, such as SCRIPT files. You do
not need them for binary files.

JISCII This option is valid for Japanese DBCS sessions only and performs
the following:
v Converts 1-byte workstation codes to EBCDIC codes.
v Converts 2-byte codes to IBM kanji codes.
v Inserts SO and SI characters in the DBCS field.

LRECL(n)
Specifies the record length for a new data set on your MVS/TSO
volume, where n is a whole number from 1 through 32760
representing the number of characters per record. If you want to
set the record length for a new data set, replace n with the new
length. If you omit this option, the record length is set to 80 for
fixed-length records and to 255 for variable-length records. If you
use the (member-name) or APPEND options, do not use this
option.

NOCLEAR
Suppresses the sending of a Clear command at the beginning of
the file transfer. This option is required for ISPF command mode.

NOSO
This option is valid only for DBCS when used with the JISCII or
ASCII option and performs the following:
v Does not insert SO (hex 0E) and SI (hex 0F) before and after a

DBCS field.
v Does not convert RS (hex 1E) and US (hex 1F) to SO (hex 0E)

and SI (hex 0F).
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PROGRESS
Shows a message indicating that the file transfer is in progress or
has ended. Such messages do not show the current transferred
bytes.

QUIET
Does not show any messages.

RECFM(x)
Specifies the record format for a new data set on your MVS/TSO
volume, where x = V, F, or U. For variable-, fixed- or
undefined-length records in the data set, replace the x with V, F, or
U, respectively.

If you omit this option, the record format of the host data set is
determined by the setting of the CRLF parameter: if you specify
CRLF, the data set has variable-length records; if you do not
specify CRLF, it has fixed-length records. If you use the
(member-name) or APPEND options, do not use this option.

SPACE(n[,n1]) unit
Specifies an amount of space to be set aside for a new data set on
your MVS/TSO volume. To set aside a certain number of blocks,
tracks, or cylinders for the new data set:
v Provide unit as the type of space you want (AVBLOCK,

TRACKS, or CYLINDERS).
v Give n as the amount of space that you want the data set to

occupy (in the unit of measure you select).
v If the data set needs more space than you ask for with n, give

n,n1 where n1 is the size of additional space to be used only
when necessary.

These values are similar to the values on the ALLOCATE
command of MVS/TSO.

If you omit this option, you get space for one block. The length of
the block is set by the BLKSIZE(n) or LRECL(n) options. If you use
the (member-name) or APPEND options, do not use this option.

TIME(n)
Specifies the length of time, in units of 30 seconds, that the
program waits for a response from the host before it sends an error
message. The value n is an integer value in the range from 0
through 2184. If you specify 0, timeout is not set. The default is 1.
To avoid a premature error message, specify an adequate value. In
cases of large packet sizes, of large block sizes, or for slow
communication lines (such as SDLC and COM port), 5 (150
seconds) is recommended. There should be no blank spaces
between TIME and (n).

Command Syntax for Sending Files to MVS/TSO: The following examples show
the command syntax you can use to send files from your workstation to an
MVS/TSO host:

Note: For Japanese DBCS sessions, use the JISCII rather than the ASCII option. For
Hangeul, Simplified Chinese, and Traditional Chinese DBCS sessions, use
the ASCII rather than the JISCII option.

v To send a file from your default drive to replace a file on the MVS/TSO host:

58 Personal Communications 3270 Emulator User’s Reference



SEND pc.txt g:ds.script ASCII CRLF

SEND pc.txt g:ds.script [JISCII CRLF (for DBCS)

This command sends a workstation file named PC.TXT from your default drive
to your MVS/TSO host in a host session named G. It creates or replaces a data
set named DS.SCRIPT on your MVS/TSO volume.

v To send a file from a drive other than the default to your MVS/TSO host:
SEND a:pc.txt g:ds.script ASCII CRLF

SEND a:pc.txt g:ds.script [JISCII CRLF (for DBCS)

This command sends a workstation file named PC.TXT from a diskette in
drive A to your MVS/TSO host in a host session named G. It replaces a data set
named DS.SCRIPT on your MVS/TSO volume.

v To send a file from your default drive to your MVS/TSO host and add it to the
end of an MVS/TSO data set:
SEND a:pc.txt g:ds.script ASCII CRLF APPEND

SEND a:pc.txt g:ds.script [JISCII CRLF APPEND (for DBCS)

This command sends a workstation file named PC.TXT from a diskette in
drive A to your MVS/TSO host in a host session named G. It adds the file to
the end of a data set named DS.SCRIPT on your MVS/TSO volume.

v To send a file to your MVS/TSO host and add it to the end of a data set that has
a password:
SEND a:pc.txt g:ds.script/odyssey8 ASCII CRLF APPEND

SEND a:pc.txt g:ds.script/odyssey8 [JISCII CRLF APPEND (for DBCS)

This command sends a workstation file named PC.TXT from a diskette in
drive A to your MVS/TSO host in a host session named G. It adds the file to
the end of a data set named DS.SCRIPT on your MVS/TSO volume. This data
set has a password of odyssey8.

v To send a file from a subdirectory on your hard disk to a partitioned data set on
your MVS/TSO host:
SEND c:\sd1\pc.txt g:ds.script (m1) ASCII CRLF

SEND c:\sd1\pc.txt g:ds.script (m1) [JISCII CRLF (for DBCS)

This command sends a workstation file named PC.TXT from a subdirectory
named \SD1 on your hard disk to your MVS/TSO host in a host session named
G. It creates or replaces a member named M1 in a partitioned data set named
DS.SCRIPT on your MVS/TSO volume.

v To send a file to a partitioned data set that has a password:
SEND a:pc.txt g:ds.script (m2)/ili11 ASCII CRLF APPEND

SEND a:pc.txt g:ds.script (m2)/ili11 [JISCII CRLF APPEND (for DBCS)

This command sends a workstation file named PC.TXT from a diskette in
drive A to your MVS/TSO host in a host session named G. It adds the file as a
member named M2 to a partitioned data set named DS.SCRIPT on your
MVS/TSO volume. In this example, the data set has a password of ili11.

v To send a file from your default drive and add it as a new data set on your
MVS/TSO volume:
SEND pc.txt g:ds.script/aeneid20 ASCII CRLF LRECL(132)

BLKSIZE(132) RECFM(V) SPACE(20,10) TRACKS

SEND pc.txt g:ds.script/aeneid20 [JISCII CRLF LRECL(132)
BLKSIZE(132) RECFM(V) SPACE(20,10) TRACKS (for DBCS)
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This command sends a workstation file named PC.TXT from your default drive
to your MVS/TSO host. It adds the file as a new data set named DS.SCRIPT on
your MVS/TSO volume. A password of aeneid20 is assigned. The records in the
data set can vary in length up to 132 characters. Data blocks are the same length
as the records. Twenty tracks are set aside for this data set. If more tracks are
needed, they are added in groups of 10.

Using the MVS/TSO RECEIVE Command
Use the following information when receiving a file from MVS/TSO:

Figure 4 shows the command and information you must provide. Enter it as shown
(including parentheses), except that you can use either uppercase or lowercase
letters.

Notes:

1. � means to insert a space. There must not be a space between h: and fn.
2. For DBCS sessions, insert a left bracket ([) before (options.

�A� The workstation drive and path to the directory where the file is to be
stored.

�B� The name of the workstation file to receive.

�C� The short name of the host session, and the data set name of the file you
are receiving.

�D� The member name if the file is put in a partitioned data set.

�E� The password of the data set, if any.

�F� Optional changes made to the file during transfer. More than one option
can be specified. Valid options are:
v APPEND
v ASCII
v BLANK
v CRLF
v JISCII (for Japanese DBCS sessions)
v PROGRESS
v QUIET
v SO
v TIME(n)
v USER

The parts of the MVS/TSO RECEIVE commands are:

RECEIVE
The command.

Figure 4. MVS/TSO RECEIVE Command Syntax
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d: The name of the diskette or hard disk drive where the file is to be located.
Use A:, B:, C:, D: through Z:. This part is optional if the file is received on
the current drive.

path The subdirectory where you want the data set located. This part is
optional.

filename.ext
The name the file is to have on your diskette or hard disk. Creates a new
name or uses a name that is already on your diskette or hard disk.

If you use a new name, the data set that you receive is added to your
diskette or hard disk. If you use the name of an existing file, the data set
that you receive either replaces or supplements the existing file. (Refer to
the APPEND option on page 61.)

h: The short name of the MVS/TSO session where the data set is located. If
you have only one host, this part is optional. Use this option if you have
more than one host. The default short name is A.

data-set-name
The name of the data set or the partitioned data set that contains the
member you want to send to your workstation session. You must use the
qualified name. Enclose the data set name with the member name in single
quotation marks if you are using a fully qualified data set name.

(member-name)
The member name of a partitioned data set to send to your workstation
session. This part is optional. Use it only if the data set is a member of a
partitioned data set.

/password
The password of the data set. Use it only if the data set has a password.

(options or [(options (for DBCS)
These options can be specified:

APPEND
Adds the data set to the end of an existing file. Omit this part if
you want the MVS/TSO data set to replace an existing workstation
file.

ASCII Performs the following:
v Converts EBCDIC codes to 1-byte workstation codes.
v Converts IBM host DBCS codes to 2-byte codes.
v Removes SO and SI characters from a DBCS field.

BLANK
This option is valid with the option CRLF; it retains BLANK (hex
40) at the end of each line.

CRLF Specifies the use of carriage return and line feed codes. You need
ASCII and CRLF for text or source files that you want to view or
edit, such as SCRIPT files. You do not need them for binary files.

JISCII This option is valid for Japanese DBCS sessions only and performs
the following:
v Converts EBCDIC codes to 1-byte workstation codes.
v Converts IBM kanji codes to 2-byte codes.
v Removes SO and SI characters from a DBCS field.
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PROGRESS
Shows a message indicating that the file transfer is in progress or
has ended. Such messages do not show the current transferred
bytes.

QUIET
Does not show any messages.

SO This option is valid only for DBCS when used with the JISCII or
ASCII option; it converts SO (hex 0E) and SI (hex 0F) to RS (hex
1E) and US (hex 1F).

TIME(n)
Specifies the length of time, in units of 30 seconds, the program
waits for a response from the host before it sends an error
message. Replace n with an integer value in the range from 0
through 2184. If you specify 0, timeout is not set. The default is 1.
To avoid a premature error message, specify an adequate value. In
cases of large packet sizes, of large block sizes, or for slow
communication lines (such as SDLC and COM port), 5 (150
seconds) is recommended. There should be no blank spaces
between TIME and (n).

USER This option is valid only for DBCS when used with the JISCII,
ASCII and SO options. SO (hex 0E) and SI (hex 0F) are not
converted to RS (hex 1E) and US (hex 1F); they are written to a file
without being converted.

Command Syntax for Receiving Files from MVS/TSO: The following examples
show the command syntax you can use to receive files from your MVS/TSO host
to your workstation:

Note: For Japanese DBCS sessions, use the JISCII rather than the ASCII option. For
Hangeul, Simplified Chinese, and Traditional Chinese DBCS sessions, use
the ASCII rather than the JISCII option.

v To receive a data set from an MVS/TSO host to the default drive for your
workstation session:
RECEIVE pc.txt g:ds.script ASCII CRLF

RECEIVE pc.txt g:ds.script [JISCII CRLF (for DBCS)

This command sends a data set named DS.SCRIPT from your MVS/TSO volume
in a host session named G to your OS/2 session. It creates or replaces the file on
the default drive with the name PC.TXT.

v To receive a data set from an MVS/TSO host to a drive other than your default
drive:
RECEIVE A:pc.txt g:ds.script ASCII CRLF

RECEIVE A:pc.txt g:ds.script [JISCII CRLF (for DBCS)

This command sends a data set named DS.SCRIPT from your MVS/TSO volume
in a host session named G. It replaces a file named PC.TXT on a diskette in
drive A.

v To receive a data set from an MVS/TSO host and add it to a workstation file:
RECEIVE a:pc.txt g:ds.script ASCII CRLF APPEND

RECEIVE a:pc.txt g:ds.script [JISCII CRLF APPEND (for DBCS)
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This command sends a data set named DS.SCRIPT from your MVS/TSO volume
in a host session named G. It adds the data set to the end of a file named
PC.TXT on the diskette in drive A.

v To receive a data set from an MVS/TSO host and place it in a subdirectory on
your hard disk:
RECEIVE c:\sd1\pc.txt ds.script ASCII CRLF

RECEIVE c:\sd1\pc.txt ds.script [JISCII CRLF (for DBCS)

This command sends a data set named DS.SCRIPT from your MVS/TSO volume
in a host session named G. It creates or replaces a file named PC.TXT in a
subdirectory named \SD1 on your hard disk.

v To receive a data set that has a password from an MVS/TSO host to your
default drive:
RECEIVE A:pc.txt g:ds.script/odyssey8 ASCII CRLF APPEND

RECEIVE A:pc.txt g:ds.script/odyssey8 [JISCII CRLF APPEND (for DBCS)

This command sends a data set named DS.SCRIPT from your MVS/TSO volume
in a host session named G. The data set has the password odyssey8. The data set
is added to the end of a file named PC.TXT on the diskette in drive A.

v To receive a member of a partitioned data set from an MVS/TSO host to your
DOS session:
RECEIVE c:\sd1\pc.txt g:ds.script (m1) ASCII CRLF

RECEIVE c:\sd1\pc.txt g:ds.script (m1) [JISCII CRLF (for DBCS)

This command sends a member named M1 from a partitioned data set named
DS.SCRIPT in a host session named G. The member is placed on your hard disk
in a subdirectory named \SD1. It replaces or creates a file named PC.TXT.

v To receive a member of a partitioned data set that has a password to your
Windows session:
RECEIVE a:pc.txt g:ds.script (m2)/ili1 ASCII CRLF APPEND

RECEIVE a:pc.txt g:ds.script (m2)/ili1 [JISCII CRLF APPEND (for DBCS)

This command sends a member named M2 from a partitioned data set named
DS.SCRIPT in a host session named G. The data set has a password of ili1. The
member is added to a file named PC.TXT on the diskette in drive A.

Using the CICS SEND Command
Please note the differences between the Personal Communications GUI and
Command Line syntaxes. These two syntaxes are not interchangeable.

Using CICS SEND with the Personal Communications GUI: Use the following
information when sending a file to CICS using the Personal Communications
graphical user interface (GUI):

Figure 5 on page 64 shows the command and information you must provide. Enter
it as shown (including parentheses), except that you can use either uppercase or
lowercase letters.

Notes:

1. � means to insert a space. There must not be a space between h: and fn.
2. For DBCS sessions, insert a left bracket ([) before (options.
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�A� The workstation drive and path of the file to send.

�B� The name of the workstation file to send.

�C� The short name of the host session, and the host file name of the file to
send.

�D� Optional changes made to the file during transfer. More than one option
can be specified. Valid options are:
v ASCII
v BINARY (for SBCS sessions)
v CLEAR
v CRLF
v JISCII (for Japanese DBCS sessions)
v NOCLEAR
v NOCRLF (for SBCS sessions)
v NOSO
v PROGRESS
v QUIET
v TIME(n)

Note: For SBCS sessions, the default options are ASCII and CRLF; for
DBCS sessions, the default option is BINARY.

Using CICS SEND with the Personal Communications Command Line: Use the
following information when sending a file to CICS using the Personal
Communications command line:

Figure 6 shows the command and information you must provide. Enter it as shown
(including parentheses), except that you can use either uppercase or lowercase
letters.

Notes:

1. � means to insert a space. There must not be a space between h: and fn.
2. For DBCS sessions, insert a left bracket ([) before (options.

�A� The workstation drive and path of the file to send.

�B� The name of the workstation file to send.

�C� The short name of the host session (h:), the host file name (fn), and the file
type (ft).

Figure 5. CICS SEND Personal Communications GUI Syntax

SEND b

A B C D

[   ] [ d: ] [ path ]" [ h: ] fn [ ft ] [ b (options) ]filename.ext [   ]  b"

Figure 6. CICS SEND Command Line Syntax
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�D� Optional changes made to the file during transfer. More than one option
can be specified. Valid options are:
v ASCII
v BINARY (for SBCS sessions)
v CLEAR
v CRLF
v JISCII (for Japanese DBCS sessions)
v NOCLEAR
v NOCRLF (for SBCS sessions)
v NOSO
v PROGRESS
v QUIET
v TIME(n)

Note: For SBCS sessions, the default options are ASCII and CRLF; for
DBCS sessions, the default option is BINARY.

CICS SEND Command Description and Options: The parts of the CICS SEND
command are:

SEND The command.

d: The name of the diskette or hard disk drive where the file is located.

path The path to the subdirectory that the file is in.

filename.ext
The name of the file to be sent, including the extension.

h: The short name of the host session where you want to send the file. If you
have only one host, this part is optional. The default is session A.

fn The name the file is to have on your CICS disk. You must specify the file
name. You can create a new name or use a name that is already on the
disk.

ft The type of file in CICS. For use only with command line syntax, see
“Using CICS SEND with the Personal Communications Command Line”
on page 64.

(options or [(options (for DBCS)
These options can be specified:

ASCII Performs the following:
v Converts 1-byte workstation codes to EBCDIC codes.
v Converts 2-byte codes to IBM host DBCS codes.
v Inserts SO and SI characters in a DBCS field and converts the

control characters ← and →, if they are present, to SO and SI
characters.

The default is ASCII CRLF. You need these control terms for text
or source files that you want to view or edit, such as SCRIPT files.
You do not need them for binary files.

Notes:

1. CRLF and NOCRLF are mutually exclusive options.
2. BINARY and ASCII are mutually exclusive options.
3. The assumed defaults, if the optional parameters are omitted,

are CRLF ASCII.
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BINARY
Specifies that the data in the file is binary data. The data can be
encrypted, compiled programs, or other data. It is not translated by
the host file transfer program but copied unaltered into a
temporary storage queue.

This option is valid for SBCS sessions only.

CLEAR
Clears the workstation window at the beginning of the file transfer.

CRLF Specifies carriage return and line feed codes in the text file.

JISCII This option is valid for Japanese DBCS sessions only and performs
the following:
v Converts 1-byte workstation codes to EBCDIC codes.
v Converts 2-byte codes to IBM kanji codes.
v Inserts SO and SI characters in a DBCS field and converts the

control characters ← and →, if they are present, to SO and SI
characters.

NOCLEAR
Suppresses the sending of a Clear command at the beginning of
file transfer. This option is required for ISPF command mode.

NOCRLF
Specifies that the PC file does not consist of logical records
delimited by carriage return and line feed characters. No
concatenation or splitting of records is performed by the CICS file
transfer program.

The file is written into a temporary storage using one item on the
queue to represent each inbound data buffer. The items on the
CICS temporary storage queue can be of different lengths, but
none can be more than 32767 characters.

This option is valid for SBCS sessions only.

NOSO
This option is valid only for DBCS when used with the JISCII or
ASCII option and performs the following:
v Does not insert SO (hex 0E) and SI (hex 0F) before and after a

DBCS field.
v Does not convert RS (hex 1E) and US (hex 1F) to SO (hex 0E)

and SI (hex 0F).

PROGRESS
Shows a message indicating that the file transfer is in progress or
has ended. Such messages do not show the current transferred
bytes.

QUIET
Does not show any messages.

TIME(n)
Specifies the length of time, in units of 30 seconds, the program
waits for a response from the host before it sends an error
message. Replace n with an integer value in the range from 0
through 2184. If you specify 0, timeout is not set. The default is 1.
To avoid a premature error message, specify an adequate value. In
cases of large packet sizes, large block sizes, or for slow
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communication lines (such as SDLC and COM port), 5 (150
seconds) is recommended. There should be no blank spaces
between TIME and (n).

Command Syntax for Sending Files to CICS: The following examples show the
command syntax you can use to send files from your workstation to your CICS
host.

Note: For Japanese DBCS sessions, use the JISCII rather than the ASCII option. For
Hangeul, Simplified Chinese, and Traditional Chinese DBCS sessions, use
the ASCII rather than the JISCII option.

v To send a workstation file from your default drive and add it as a new file on
your CICS host:
SEND pc.txt a:cicsfile (ASCII CRLF)

SEND pc.txt a:cicsfile [(JISCII CRLF) (for DBCS)

Note: Enter the complete CICS SEND command on one line.

This command sends a workstation file named PC.TXT from your default drive
on your workstation to your host session A. You do not need to provide the
workstation drive name if the file you are sending is on the current drive. The
command creates a new file named CICSFILE.

v To send a basic workstation file from a drive other than your default to replace a
file on your CICS host:
SEND a:myprog.exe a:basprog

This command sends a workstation file named MYPROG.EXE from a diskette in
drive A to your CICS host in your host session named A. It is written to a file
named BASPROG, replacing any existing file by that name in host session A.

Using the CICS RECEIVE Command
Please note the differences between the Personal Communications GUI and
Command Line syntaxes. These two syntaxes are not interchangeable.

Using CICS RECEIVE with the Personal Communications GUI: Use the
following information when receiving files from CICS using the Personal
Communications GUI:

Figure 7 shows the command and information you must provide. Enter it as shown
(including parentheses), except that you can use either uppercase or lowercase.

Notes:

1. � means to insert a space. There must not be a space between h: and fn.
2. For DBCS sessions, insert a left bracket ([) before (options.

�A� The workstation drive and path where the file is to be received.

�B� The name of the workstation file.

Figure 7. CICS RECEIVE Personal Communications GUI Syntax
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�C� The short name of the host session (h:) from which you are receiving the
file, and the host file name (fn).

�D� Optional changes made to the file during transfer. More than one option
can be specified. Valid options are:
v ASCII
v BINARY (for SBCS sessions)
v BLANK
v CLEAR
v CRLF
v JISCII (for Japanese DBCS sessions)
v NOCLEAR
v NOCRLF (for SBCS sessions)
v PROGRESS
v QUIET
v SO
v TIME(n)
v USER

Note: The default options for SBCS sessions are ASCII and CRLF; the
default option for DBCS sessions is BINARY.

Using CICS RECEIVE with the Personal Communications Command Line: Use
the following information when receiving files from CICS using the Personal
Communications command line:

Figure 8 shows the command and information you must provide. Enter it as shown
(including parentheses), except that you can use either uppercase or lowercase.

Notes:

1. � means to insert a space. There must not be a space between h: and fn.
2. For DBCS sessions, insert a left bracket ([) before (options.

�A� The workstation drive and path where the file is to be received.

�B� The name of the workstation file.

�C� The short name of the host session (h:) from which you are receiving the
file, the host file name (fn), and the file type (ft).

�D� Optional changes made to the file during transfer. More than one option
can be specified. Valid options are:
v ASCII
v BINARY (for SBCS sessions)
v BLANK
v CLEAR
v CRLF
v JISCII (for Japanese DBCS sessions)
v NOCLEAR

RECEIVE b

A B C D

[   ] [ d: ] [ path ]" [ h: ] fn [ ft ] [ b (options) ]filename.ext [   ]  b"

Figure 8. CICS RECEIVE Command Syntax
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v NOCRLF (for SBCS sessions)
v PROGRESS
v QUIET
v SO
v TIME(n)
v USER

Note: The default options for SBCS sessions are ASCII and CRLF; the
default option for DBCS sessions is BINARY.

CICS RECEIVE Description and Options: The parts of the CICS RECEIVE
command are:

RECEIVE
The command.

d: The name of the diskette or hard disk drive where the file is to be
received.

path The path to the subdirectory where the file is to be located.

filename.ext
The name of the workstation file, including the extension. You can create a
new name or use a name that is already on your workstation diskette or
hard disk. If you use a new name, the file that you receive is added to
your diskette or hard disk. If you use the name of an existing file, the file
that you receive either replaces or supplements the existing file. Refer to
the APPEND option.

h: The short name of the CICS session where the data set is located. If you
have only one host, this part is optional. The default session is A.

fn The name of the file you want to receive from your CICS host.

ft The type of file in CICS. For use only with command line syntax, see
“Using CICS RECEIVE with the Personal Communications Command
Line” on page 68.

(options or [(options (for DBCS)
These options can be specified:

ASCII Performs the following:
v Converts EBCDIC codes to 1-byte workstation codes.
v Converts IBM host DBCS codes to 2-byte codes.
v Inserts SO and SI characters in a DBCS field and converts the

control characters ← and →, if they are present, to SO and SI
characters.

The default is ASCII CRLF. You need ASCII and CRLF control
terms for text or source files that you want to view or edit, such as
SCRIPT files. You do not need them for binary files.

Notes:

1. CRLF and NOCRLF are mutually exclusive options.
2. BINARY and ASCII are mutually exclusive options.
3. The assumed defaults, if the optional parameters are omitted,

are CRLF ASCII.

BINARY
The data in the file is binary data. The data can be encrypted data,
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compiled programs, or other data. It is not translated by the host
file transfer program but is copied without changes into the
workstation file.

This option is valid for SBCS sessions only.

BLANK
This option is valid only when used with the CRLF option; it
retains BLANK (hex 40) at the end of each line.

CLEAR
Clears the workstation window at the beginning of the file transfer.

CRLF Specifies the use of the carriage return and line feed codes.

JISCII This option is valid for Japanese DBCS sessions only and performs
the following:
v Converts EBCDIC codes to 1-byte workstation codes.
v Converts IBM kanji codes to 2-byte codes.
v Inserts SO and SI characters in a DBCS field and converts the

control characters ← and →, if they are present, to SO and SI
characters.

NOCLEAR
Suppresses the sending of a Clear command at the beginning of
file transfer. This option is required for ISPF command mode.

NOCRLF
Specifies that the host computer file does not consist of logical
records. The items in the temporary storage queue are sent in order
and concatenated in your workstation into a single string of data.

This option is valid for SBCS sessions only.

PROGRESS
Shows a message indicating that the file transfer is in progress or
has ended. Such messages do not show the current transferred
bytes.

QUIET
Does not show any messages.

SO This option is valid only for DBCS when used with the JISCII or
ASCII option; it converts SO (hex 0E) and SI (hex 0F) to RS (hex
1E) and US (hex 1F).

TIME(n)
Specifies the length of time, in units of 30 seconds, the program
waits for a response from the host before it sends an error
message. Replace n with an integer value in the range from 0
through 2184. If you specify 0, timeout is not set. The default is 1.
To avoid a premature error message, specify an adequate value. In
cases of large packet sizes, of large block sizes, or for slow
communication lines (such as SDLC and COM port), 5 (150
seconds) is recommended. There should be no blank spaces
between TIME and (n).

USER This option is valid only for DBCS when used with the options
JISCII, ASCII, and SO. SO (hex 0E) and SI (hex 0F) are not
converted to RS (hex 1E) and US (hex 1F); they are written to a file
without being converted.
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Command Syntax for Receiving Files from CICS: The following examples show
the command syntax you can use to receive files from your CICS host to your
workstation.

Note: For Japanese DBCS sessions, use the JISCII rather than the ASCII option. For
Hangeul, Simplified Chinese, and Traditional Chinese DBCS sessions, use
the ASCII rather than the JISCII option.

v To receive a file from your CICS host to your default drive for a workstation
session:
RECEIVE pc.txt A:cicsfile (ASCII CRLF)

RECEIVE pc.txt A:cicsfile [(JISCII CRLF) (for DBCS)

This command sends a file named CICSFILE from your CICS host in session A
to your workstation session. It adds the file to your default drive (diskette or
hard disk) with the name PC.TXT.

v To receive a basic file from your CICS host and replace a file on a drive other
than your default:
RECEIVE a:myprog.exe a:myprog

This command sends a file named MYPROG from your CICS host in session A
to a drive other than the default for your workstation session. It replaces a file
named MYPROG.EXE on a diskette in drive A.

Configuring File-Transfer Code Translation
When you transfer a file between the host and the workstation using the ASCII
option (JISCII, for Japanese DBCS sessions), the host-system file-transfer program
performs translation from EBCDIC to ASCII (JISCII, for Japanese DBCS sessions) or
vice versa, according to the host and PC code pages specified during PC/3270
configuration. However, you might want to use different translation from that
supplied by IBM. For the details, refer to Chapter 4, “Transferring Files” on
page 35.
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Chapter 5. Printing

You can use Personal Communications to print from display or printer sessions.

From display sessions, you can print all (Print Screen) or part (Trim Print) of the
screen of your session window on a workstation printer. For more information,
refer to Quick Beginnings or the online help.

You can map a key sequence to bring up the Printer Setup dialog. There is no
default key combination for this function. See “Default Key Function Assignments”
on page 27 for more information about keyboard functions.

From printer sessions, you can direct printing from an S/390 system to a
workstation printer.

Note: When you use a host application which prints to your workstation’s LPT1,
you must first select the printer in the Printer Setup dialog of the File
menu.

Configure a printer session to designate a workstation printer as a system printer
that will use either a Windows printer driver or a printer definition table (PDT)
provided with Personal Communications.
v Use Windows printer drivers for Personal Communications to print files based

on printer setup parameters, such as scaling, duplex options, and page
orientation, that you define in Printer Setup.

v Use PDT files for Personal Communications to print files based on page setup
information, such as control codes and the printer output format, defined in the
PDT. You can customize PDTs to define your own controls, by editing the
corresponding printer definition file (PDF) and converting it to a PDT.

From a 3270 display session, you can also use the ZipPrint utility provided in the
Emulator Utilities folder to print PROFS® or OfficeVision® (OV) notes, calendars,
documents, CMS files, XEDIT workspaces, and host-session screens. See the online
help for more information.

For considerations and restrictions on printing, refer to Chapter 3, “Considerations
for Using PC/3270 Sessions” on page 15.

Setting Up the Printer
Following is a description of how to set up your printer with either a Windows
printer driver or a PDT file.

For an explanation of how to customize a PDT, refer to Chapter 3, “Considerations
for Using PC/3270 Sessions” on page 15.

Defining a Printer for a Session
To choose or change the Windows printer driver to be used, follow these steps:
1. Click Printer Setup from the File menu of the session window.

The Printer Setup window lists the available printers.
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2. Select a printer from the list box. If desired, select the check box Show this
dialog before every print.

Note: The Default selection causes the current Windows default printer to be
used.

3. Confirm that Use PDT is not selected.

Telnet 3270E Printer Association
The Telnet 3270E standard lets you specify an association between a display and a
printer session. This is unique to telnet, and is not available in the SNA
environment. When you configure a display session, Personal Communications lets
you specify an associated printer session. This function is implemented on CS/NT
and CS/390 TN3270E servers.

The association starts at the telnet server. In the server’s configuration, there is a
one-to-one correspondence when defining associated printers. When LU names
and relations are already defined by the server, the server will assign the printer
LU for the client. Each printer LU is configured as associated with a particular
display LU.

Advantages of this association are as follows:
v If sessions are associated, the person who configures the client workstation does

not have to know any detail about the printer session because the associated
pairs are defined at the telnet server.

v When you start the display session, the associated printer session is started
automatically. If the printer session is configured to direct output to a printer
that is near you, and if you ensure that your host applications print to that
session, it is obviously convenient.

Note: Stopping a TN3270E session will automatically close an associated printer
session, if that option was selected when configuring the session.

Using PDT Files
To use a PDT file:
1. Click File → Printer Setup from the menu bar of the session window.

The Printer Setup window appears.
2. Click the printer to be used from the list box.
3. Click Setup; specify the paper size.
4. Click OK.
5. Click the Use PDT check box, then Select PDT.

The Select PDT file window appears.
6. Do one of the following:

v To use an existing PDT, select the PDT file to be used; then click OK.
v To use a PDF that you have modified, you must first convert it to a PDT. To
do so:
a. Click Convert PDF.
b. Select the PDF file to be converted from the list, then click Convert.

The window displays the result of the conversion. If there are any errors
during the conversion, they are listed in the window.

c. When you select Save List, the window list is saved in *.LST file in the
PDFPDT subdirectory.
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To close without saving the list, click Close.
After the file is converted, control returns to the Select PDT file window and
the converted PDT file appears in the list.

d. Select the PDT file; then click OK.
7. Click OK in the Printer Setup window.

PDT Files

Basic Support
PDTs (printer definition tables) are compiled from PDFs (printer definition files).
PDFs contain printer commands that must be understood/supported by your
printer.

The following are the basic printer languages:

PCL Printer Control Language (Hewlett-Packard)

PPDS ProPrinter Data Stream (IBM)

ESC/P Printer Control Language (Epson)

POSTSCRIPT
(No PDFs for this language)

Many printers support two or more of these languages. Most print drivers use a
PJL (Printer Job Language) to switch between languages and to perform other job
control functions, such as setting the number of copies.

You do not need a PDF for each different printer model; with the increasing
number of models, PDFs are named for the printer language, not the printer
model.

Older SBCS PDFs and PDTs are not shipped with Personal Communications, but
are available at the following website:
http://www.ibm.com/software/network/pcomm. If you have already modified
PDFs, any PDF and PDTs with names different from those in Table 8 are retained
during an install.

Note: All DBCS PDFs and PDTs are still shipped with Personal Communications.

The End_Job statement in a PDF contains the printer commands that are sent to the
printer at the end of each print job. If the End_Job contains a character defined as
form feed (FFF in the PDT), a form feed (FF) is sent to the printer. FF in the
End_Job statement is not needed if the host application ends the job with the FF, as
is commonly done. Some print drivers add the FF if needed, and most print
drivers ignore extra FFsl. So the FFF is usually protection against the host
application not using a FF, and usually causes no problem. However, if you get an
extra blank page, remove the FFF.

Note: This procedure is valid for host printer sessions but not for Print Screen
from a display session

Table 8. Old Printer Definition Files

Printer Definition File (PDF) Name Remarks

esc_p (3270 only) (DBCS only)
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Table 8. Old Printer Definition Files (continued)

Printer Definition File (PDF) Name Remarks

ibm5577 (No FFF) (DBCS only)

ibm5577a (No FFF)

ibm5577b (No FFF)

ibm5585 (No FFF) (3270 only) (DBCS only)

ibm5587 (No FFF) (3270 only) (DBCS only)

lbp4

lips3a4 (No FFF) (DBCS only)

lips3b4 (No FFF) (DBCS only)

nppages (No FFF) (3270 only)

The supplied basic_ascii PDF does not contain any printer commands, which
results in only ASCII text being sent to a printer or file. An accompanying PDT is
also shipped. This PDF is for SBCS only.

Double-Byte Character Support
The PDTs provided by Personal Communications and the corresponding printers
are listed in Table 9. The DBCS PDTs are as follows:
v IBM5577.PDT
v IBM5577B.PDT
v IBM5585.PDT
v IBM5587.PDT
v ESC_P.PDT
v LIPS3A4.PDT
v LIPS3B4.PDT
v ESC_BIG5.PDT
v ESC_CNS.PDT
v ESC_5550.PDT
v ESC_TCA.PDT
v KS_JO.PDT
v KS_WAN.PDT
v KSSM_JO.PDT
v KSSM_WAN.PDT
v NPPAGES.PDT

Table 9 lists the printers to use with supported PDTs.

Table 9. Printer Models and Supported PDTs

File Name Printer Name/Model

IBM5577.PDT IBM 4208-501, -5C2, -5K2
IBM 4216-510
IBM 5572-B02
IBM 5573-HC2
IBM 5575-B02, -F02, -H02, BC2, -FK1E
IBM 5577-B02, -G02, -H02, FC2, -HC2, -KC2,-HK2
IBM 5579-H02, -KC2

IBM5585.PDT IBM 5585-H01, -HC1
IBM 5587-G01
IBM 5587-H01 (with extended functions)
IBM 5589-H01
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Table 9. Printer Models and Supported PDTs (continued)

File Name Printer Name/Model

IBM5587.PDT IBM 5587-G01
IBM 5587-H01 (without extended functions

ESC_P.PDT ESC/P printer for China or Japan

ESC_BIG5.PDT ESC/P printer with Big5 DBCS code

ESC_CNS.PDT ESC/P printer with CNS DBCS code

ESC_5550.PDT ESC/P printer 5550 DBCS code

ESC_TCA.PDT ESC/P printer with TCA DBCS code

KS_JO.PDT KS printer with combination code

KS_WAN.PDT KS printer with completion code

KSSM_JO.PDT KSSM printer with combination code

KSSM_WAN.PDT KSSM printer with completion code

NPPAGES.PDT IBM NP12, NP17, NP24 printers for Japan

Table 10 lists the PDTs that are supported for DBCS only.

Table 10. DBCS Supported PDTs

File Name Printer Name/Model

NPPAGES.PDT IBM NP12, NP17, and NP24 in PAGES mode (Japan only)

IBM5585.PDT All types of IBM 5585 printers

IBM5587.PDT All types of IBM 5587 printers

IBM5577.PDT All types of IBM 5577 printers

IBM5577B.PDT IBM 5577-S02/T02 for Postal Bar Code Support (Japan only)

Page Setup Parameters
You can set Page Setup parameters, such as the maximum number of lines per
page, the maximum number of columns, and fonts. These parameters are initially
set to the defaults. Use this function to change specific control items.

Note: When a PDT file is used, this function cannot be used.

You can set the following parameters.

Table 11. Page Setup Parameters — Text

Parameter Description

CPI Specifies the number of characters to be printed per inch. If CPI
was not set previously, a CPI value suitable for the font selected
from the Font list box is assumed as the default.

LPI Specifies the number of lines to be printed per inch. If LPI was not
set previously, an LPI value suitable for the font selected from the
Font list box is assumed as the default.

Maximum Number of
Lines per Page

Specifies the maximum number of lines per page. A number in the
range 1–255 can be specified. The default is 66. See Note 1.

Maximum Number of
Characters per Line

Specifies the maximum number of characters per line. A number in
the range 1–255 can be specified. The default is 132. See Note 2.
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Table 11. Page Setup Parameters — Text (continued)

Parameter Description

Font Lists, in the list box, the monospaced fonts that can be used with
the currently selected printer.

The fonts in brackets [ ] are device fonts specific to the printer
driver. The other fonts are graphics display interface (GDI) fonts
printed in bit map formats.

Notes:

1. When you set this to a value other than the default, Personal Communications uses it
to scale the LPI and font to the best fit for the page.

2. When you set this to a value other than the default, Personal Communications uses it
to scale the CPI and font to the best fit for the page.

From a Personal Communications display session, you can set additional
parameters by selecting the Text Options tab, as follows:

Table 12. Page Setup Parameters — Text Options

Group Options Setting

Print Options The following
options can be selected as print
options. These options are not
available for the printer session.

Suppress null lines Determines whether to delete
lines containing only null or
non-printable characters (null
or non-printable field
characters, and field attributes)
or to print them as null lines.

Selected
Null lines are not
printed.

Not selected
Null lines are printed.

This option can be used when:

v The Print Screen command
is used

v LU type 3 printing, or
non-SNA printing is done

v The combination of bits 2
and 3 of the WCC is not 00.

Print nulls as spaces Determines whether to print
NULL control codes as null
characters.

Selected
The codes are printed
as blanks.

Not selected
The codes are treated
as null characters.

This option can be used when:

v The Print Screen command
is used

v LU type 1 or 3 printing, or
non-SNA printing is done.
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Table 12. Page Setup Parameters — Text Options (continued)

Group Options Setting

Ignore FF when at
first print position

Determines whether to ignore
the FF code at the beginning
of the buffer address.

Selected
The FF code is
ignored and not
executed.

Not selected
The FF code is
executed.

This option can be used when:

v The Print Screen command
is used

v LU type 1, LU type 2, LU
type 3, or non-SNA printing
is done.

FF takes a print
position if followed
by data

Determines whether to print
null characters if data follows
the FF code.
Selected

FF is executed, and a
blank character is
printed at the
beginning of the next
page. Therefore, the
next data is printed
in the second column
of the line.

Not selected
FF is executed, and
the next data is
printed at the
beginning of the first
line on the next page.

This option can be used when:

v The Print Screen command
is used

v Host initiated local copy
and LU type 3 printing, or
non-SNA printing is done

v In both PDT and standard
modes
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Table 12. Page Setup Parameters — Text Options (continued)

Group Options Setting

Suppress auto new line when: CR at maximum print
position +1 Determines whether to

perform automatic new line
when CR is the maximum
number of columns to be
printed away from the first
column.
Selected

Automatic new line is
not done. The
characters after the
CR code are printed
on the same line.

Not selected
Automatic new line is
done.
Determines whether
to perform automatic
new line/carriage
return before new
line/carriage return
(NL) is done when
NL is the maximum
number of columns to
be printed away from
the first column.

NL at maximum print
position +1 Selected

Automatic new line is
not done.

Not selected
After automatic new
line is done, new line
is done again.

This option can be used when
LU type 3 printing or
non-SNA printing is done and
the combination of bits 2 and
3 of the WCC is 00.

This option cannot be used in
5250 sessions.

Form Feed Position
Note: This cannot be used for
5250 sessions.

Any position Determines that printing can
start at any position on the
page.

Column 1 only Determines that printing starts
at column 1 of the page.

From a Personal Communications 3270 session, you can set additional parameters
by selecting the Graphics tab.
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Table 13. Page Setup Parameters - Graphics

Parameter Description

Scaling By default, the screen size (display resolution) is mapped to the
printed page size (printer resolution)—this is called BestFit. It is
done automatically if you change either resolution (including
changing printers). The /2, /3, and /4 values reduce the printed
page size.

Black-on-White This option allows you to determine how the black pixels on the
screen are printed.

Yes Black pixels are printed as white pixels. Pixels other than
black are printed as black pixels when you use a
monochrome printer. When you use a color printer, they
are printed in the same color as on the screen.

No Black pixels are printed in black. Pixels other than black
are printed as white pixels when you use a monochrome
printer. When you use a color printer, they are printed in
the same color as on the screen.

To set or change setup items:
1. Click File → Page Setup from the menu bar of the session window.

The Page Setup window appears.
2. Select the tab that contains the parameters you want to change.

Note: To switch from the current settings back to the defaults, select Default.
3. When all the items have been set, click OK or Apply.

Printing to Disk
If you are using a PDT, you can save a host print-job or the contents of the session
window (Print Screen) to a workstation file instead of printing it.

Two types of Print-to-Disk function are provided by Personal Communications:

Print-to-Disk Append
Appends multiple host print jobs or print screen jobs to a single
workstation file.

Print-to-Disk Separate
Saves each host-print job or screen to a separate workstation file. You can
specify the file name, but the extension is automatically assigned as a
decimal number from 000 to 999. If you delete a file, its number will be
re-used. When all 999 numbers have been used, the extension is
automatically assigned a decimal number from 1000 to 9999.

Notes:

1. Print-to-Disk is not available for the Print-Graphics function.
2. Print-to-Disk can be used only when you use a printer definition table (PDT)

file.

To set up Print-to-Disk:
1. Click File → Printer Setup from the menu bar in the session window.

The Printer Setup window lists the supported printers.
2. Select Print to Disk Append or Print to Disk Separate from the list box.
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3. Click Select PDT.
The Select PDT file window appears.

4. Select a PDT file from the list; then click OK.
The Printer Setup window reappears.

5. Click Setup.
The File Selecting window appears.

6. Specify a file name, drive, and path; then click OK.

Note: If you specify the name of an existing file, subsequent print jobs are
appended to the data in the original file in the case of Print to Disk
Append.

Printing Japan Postal Bar Code
In support of the new postal bar code implemented in Japan, Personal
Communications provides print capabilities for postal bar codes.

Workstation Profile Parameter for Code Page
Occasionally a font does not support the desired code page. The wrong characters
may be printed within the specific character set (Latin 2, for example). Personal
Communications has a workstation profile parameter that allows the program to
use a different code page that is supported by the desired font.

You can use the PrinterFontCodePage parameter if the following conditions are
met:
v If you can specify the printer font code page with which the desired font is

encoded.
v If Personal Communications provides the translation table for the host code page

and the printer font code page.

However, since some Personal Communications releases may require manual
adjustment of the workstation profile, try using different fonts before altering the
.ws file. Fonts are listed in the Personal Communications Page Setup panel for all
display sessions and 3270 host print sessions. For 5250 print sessions, the
PCSPD.DAT file can be manually changed to control the fonts used. The Courier
New font should support most languages and corresponding code pages.

To edit the .ws file, you must change the PrinterFontCodePage parameter to the
value of the supported code page you wish to use. This option must be put in the
[printers] section, and is case-sensitive. See the following example for the proper
parameter syntax. The parameter does not need to be placed immediately after the
[printers] section label.
[printers]
PrinterFontCodePage=852

In this case, the desired font is encoded with code page 852. Personal
Communications uses a different, existing translation table to translate data from
EBCDIC to 852, versus using the standard Windows code page.
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Chapter 6. SNA Node Operations

SNA Node Operations enable you to display information and manage the node for
certain Personal Communications resources, which can be useful when operating
the SNA node. The following tasks are supported:
v Starting and stopping resources
v Deleting resources
v Displaying resource information
v Changing session limits
v Initiating path switches

The configuration information for a SNA Node is stored in an ASCII file, with the
extension .ACG. You can edit the file by launching SNA Node Configuration. To
ensure that your new configuration is correct, use the Verification tool.

You can display information or take action on resources if you start 3270, 5250, or
any client/server sessions with one of the following attachment types:

System/390 Connections
LAN LAN via IEEE 802.2

3270 via AS/400
APPC 3270 via LAN
Dependent Logical Unit Requester (DLUR)
3174 Peer Communication

COM port
SNA-over-Async
IBM Global network — SNA-over-Async
Dependent Logical Unit Requester (DLUR) via:

SNA-over-Async

Hayes AutoSync
APPC 3270 via:

SNA-over-Async

Hayes AutoSync

X.25 Hayes AutoSync

X.25 DLUR via Hayes AutoSync

X.25 APPC 3270 via Hayes AutoSync
5250 3270 via AS/400

Dependent Logical Unit Requester (DLUR)
SDLC Synchronous Data Link Control

3270 via AS/400 (passthru)
APPC 3270 via SDLC
Dependent Logical Unit Requester (DLUR)

SNA/IP
LU 0, 1, 2, 3
APPC 3270
LU 0, 1, 2, 3 via DLUR

IBM ISA/MCA WAC
Synchronous Data Link Control
3270 via AS/400 (passthru)
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APPC 3270 via SDLC
Dependent Logical Unit Requester
X.25 Qualified Logical Link Control
X.25 3270 via AS/400
APPC 3270 via X.25
X.25 DLUR

IBM-EEDLC
LU (0, 1, 2, 3) via DLUR)
APPC 3270

OEM LU (0, 1, 2, 3)
3270 via AS/400 (passthru)
APPC 3270
Dependent Logical Unit Requester (DLUR)

AS/400 Connections
LAN LAN via IEEE 802.2
COM port

SNA-over-Async
Hayes AutoSync
X.25 Hayes AutoSync

SDLC Synchronous Data Link Control
SNA/IP

5250
IBM ISA/MCA WAC

Synchronous Data Link Control (WAC)
X.25 Qualified Logical Link Control

IBM-EEDLC
5250

OEM APPC 5250

Client/Server Connections
LAN LAN via IEEE 802.2
Twinaxial

Twinaxial Data Link Control (APPC)
COM port

SNA-over-Async
Hayes AutoSync
X.25

SDLC Synchronous Data Link Control
IBM WAC

Synchronous Data Link Control
X.25

AnyNet SNA over TCP/IP
APPC

Enterprise Extender
HPR over IP

SNA resources that can be displayed or managed include the following:

Connection Networks
Allows APPN nodes in a LAN to have direct links with each other without
requiring logical link definitions at each node.

Connections
Link stations to the adjacent nodes
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CPI-C Side Information
Associate a set of parameters with a specified symbolic destination name.

Data Link Controls
How data is formatted for transmission on the physical connection.

Devices
Parts of the workstation hardware, such as adapters, that are used to
transmit and receive data.

DLUR PUs
A dependent logical unit requester (DLUR) physical unit (PU) is a PU in
an APPN end node that owns dependent LUs, but requests that a
dependent LU server provide the SSCP services for those dependent LUs.

Focal Points
A system that provides centralized network management services.

Local LU 0 to 3
A local logical unit (LU) type 0, 1, 2, or 3 is a dependent LU on the
workstation that provides services for 3270 terminal and printer emulation
applications.

Local LU 6.2
A local logical unit (LU) type 6.2 is an independent or dependent LU that
provides APPC services.

LU 6.2 Sessions
Transports data between two partner LU 6.2s. Conversations between
transaction programs use LU 6.2 sessions.

Mode The name used by the initiator of a session to designate the characteristics
desired for the session, such as traffic pacing values, message-length limits,
sync point and cryptography options, and the class of service (COS) within
the transport network.

Node The control point that manages the node and its associated resources. The
local node provides APPN services.

Partner LU 6.2
A remote computer that communicates through an APPC session with local
LU 6.2s.

RTP Connections
In high-performance routing (HPR), a rapid transport protocol (RTP)
connection is the connection established between the endpoints of the route
to transport session traffic.

Transaction Programs
A transaction program (TP) is a program that processes transactions in an
SNA network. There are two kinds of TPs: application transaction
programs and service transaction programs.

Starting Node Operations
To start Node Operations, click the SNA Node Operations icon in the Personal
Communications folder; or, from an active session window, click Actions → Launch
→ SNA Node Operation.

Note: This utility can also be started using a command (see “Command-Line
Utilities” on page 87).
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Using the Menu Bar
From the menu bar of the SNA Node Operations utility, click one of the following:

Operations
To start or stop a SNA node.

To start a node, select the configuration file you want to use.

To change session limits (CNOS).

To apply a new configuration file, select the configuration file you want to
use.

Launch
To launch to other Personal Communications programs, such as Log
Viewer, Trace Facility, or SNA Node Configuration.

View To modify the layout of your Personal Communications window (Tool bar
or Status bar).

To select resource attributes, which allows you to customize the display of
SNA resource attributes.

To view frequently used resources, such as:
v Node
v Connections
v Local LU 0 to 3
v Partner LUs
v LU 6.2 sessions

Window
To modify the layout of your Personal Communications window.

Help To view the Personal Communications online help.

Displaying a Resource
To display a resource, select a resource from the pull-down list on the toolbar.

Starting a Resource
To start a resource:
1. Select a resource from the pull-down list on the toolbar.
2. Select the first column of the item, and right mouse click to display the pop-up

menu.
3. Click Start to start the resource. A started (active) resource can be stopped, but

not deleted.

Stopping a Resource
There are two ways of stopping a resource:

Normal Stop
Performs clean up and then stops the resource.

Abnormal Stop
Immediately stops the resource.

To stop a resource:
1. Select a resource from the pull-down list on the tool bar.
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2. Select the first column of the item, and right mouse click to display the pop-up.
3. Select Normal Stop or Abnormal Stop to suspend the resource. If a resource is

stopped (inactive), it can be deleted or redefined.

Deleting a Resource
To delete a resource:
1. Select a resource from the pull-down list on the tool bar.
2. Select the first column of the item, and right mouse click to display the pop-up.
3. Select Delete to delete the resource.

You should stop a resource (make it inactive) before redefining it. You do not need
to delete the resource before redefining it.

Changing an HPR Path Switch
To perform a high performance routing (HPR) path switch:
1. Select RTP connections from the pull-down list on the tool bar.
2. Select the first column of the item, and right mouse click to display the pop-up.
3. Select HPR path switch to change the path for the data on this RTP connection.

Updating SNA Resources Dynamically
It is not necessary to delete an SNA resource before redefining it. A resource must
be inactive, however, when you redefine it.

If a redefinition is rejected for a reason other than that the resource is active, a
STATE_CHECK return code is returned as well as a specific secondary return code,
as listed in the NOF specification. Most rejections are due to inconsistencies in the
configuration, such as one of the following:
v Attempting to define an LS with the adjacent CP name set to the local CP name.
v Attempting to define two link stations on a non-switched port with the same

destination address.

Such rejections occur regardless of whether you are defining a resource for the first
time or redefining it.

Keep in mind the following when redefining resources:
v You may not change the ls_role of a port that has link stations defined on it. The

link stations must be deleted before the port role can be changed (because an LS
may default to the port ls_role).

v You may not change the type of a named DLC. The DLC definition must be
deleted before the same name can be reused for a DLC of a different type.

Command-Line Utilities
Another way to perform SNA Node operations is to use the command line. Five
command line programs are available to perform basic operations for the SNA
Node.

CSSTART [ -a | -d | -m | -h ] [ -p | -q ] [ cfgfile ]

Use the CSSTART command to start the SNA Node with a specified
configuration. The -a flag enables automatic start up after rebooting the
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machine. The -d flag sets the default SNA node configuration file. The -m
flag stands for manual start which disables automatic start up after
rebooting the machine. If the -p flag is used, all messages are shown in a
message box pop-up. Messages are written to stdout by default. The -q flag
suppresses all output. The -h flag summons the help data for this
command. The cfgfile parameter is the name of the configuration file you
want to use to start the product. If no cfgfile parameter is specified, the
default configuration file is used. If no default configuration file has been
set, an error is reported. If the node is successfully started, CSSTART
returns zero, otherwise a nonzero value is returned.

CSSTOP [ -p | -q ][ -h ]

Use the CSSTOP command to stop the SNA Node. The flags have the same
meaning as for CSSTART. If the node is successfully stopped then CSSTOP
returns zero, otherwise a nonzero value is returned.

CSQUERY [ -p | -q ][-h ]

Use the CSQUERY command to query the status of the SNA Node. The
flags have the same meaning as for CSSTART. Along with the status, the
default and active configuration file names are shown. If the node is
running, then CSQUERY returns zero; otherwise a nonzero value is
returned.

CSDSPY {resource [object_id] [/D#]} | [ -h ]
Displays information about SNA node resources, where:

resource
One of the following:

AIL AnyNet IP to LU mapping

CNT Connection networks

CON Connections

CPS CPI-C side information

DLC Data link controls

DEV Devices

DPU DLUR PUs

FPT Focal Points

LU0 Local LU 0 to 3

L62 Local LU 6.2

L6S LU 6.2 sessions

MOD Modes

NOD Nodes

PLU Partner LU 6.2

RTP RTP connections

TRP Transaction programs

object_id
Specifies a case-sensitive value (for example, LU001 or LINK001) to
search for. Only objects whose first attribute matches this value are
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displayed. The object_id must be spelled correctly, including case
(upper and lower). An incorrect object_id will result in nothing
being displayed.

/D# Specifies the level of detail to display. # is a number in the range 1
– 3, where 1 displays the least level of detail and 3 shows all
information. The default is 2.

CSMODIFY {resource object_id action} | [ -h ]
Enables you to control SNA node resources, where:

resource
Is one of the following:

CON Connections. You can start, stop, or delete this resource.

CPS CPI-C side information. You can delete this resource.

DLC Data link controls. You can start, stop, or delete this
resource.

DEV Devices. You can start, stop, or delete this resource.

DPU DLUR DPUs. You can start or stop this resource.

LU0 Local LU 0 to 3. You can delete this resource unless the LU
is in use.

L62 Local LU 6.2. You can delete this resource.

RTP RTP connections. You can switch the path of this resource.

object_id
Specifies a case-sensitive value (for example, LU001 or LINK001) to
search for. Only objects whose first attribute matches this value are
displayed. The object id must be spelled correctly, including case
(upper and lower). An incorrect object id will result in an error
being displayed.

action One of the following:

SN Normal stop

SI Immediate stop

ST Start

DL Delete

PS Path switch

[-h] This switch is used to summon help data for this command.
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Chapter 7. Log Viewer Functions

The Personal Communications log viewer utility enables you to view, merge, sort,
search, and filter information contained in message and trace logs. You can use the
viewer during problem determination to work with message and trace log entries.
The default name of the message log output file is PCSMSG.MLG; its file extension
must be .MLG. The file extension for trace logs must be .TLG. Note that the Help
per Message Log Item functionality is available only for message logs.

Viewing Message and Trace Logs
To view message or trace logs:
1. From the Administrative and PD Aids folder, click Log Viewer; or, from an

active session window, click Actions > Launch > Log Viewer.
2. From the list of logged messages, click on one of the details on the log entry in

the bottom pane.

Note: If the logger device driver determines that the product kernel
driver-generated log is full and cannot log a message, it will create an entry
in the Windows log. The information logged may include which log failed,
as well as the location and reason for the failure.

Changing Message Log Size and Location
The Personal Communications log viewer utility allows you to modify the size and
location of message log files, and change the name of the default message log file.
The size of a log file is counted in kilobytes and can range from a minimum of
4Kb to a maximum limited only by available hard disk space.

To modify the location and size of the log:
1. From the Log Viewer main menu, click Options and then click Configure

Message Log Settings... A Windows common dialog box is displayed.
2. From the dialog box, browse the directory structure and choose the destination

directory and file name for the message log.
3. Using the spin control counter field, use the up and down arrows to increase or

decrease the log file size (in kilobytes).
4. Select OK to save settings and exit the window.

Merging Message and Trace Logs
The Personal Communications log viewer utility allows you to open and merge
message and trace log entries in the same log viewer window. You can merge any
combination of message and trace log files.
v .MLG into .TLG
v .TLG into .TLG
v .TLG into .MLG
v .MLG into .MLG

To merge message and trace log files:
1. From the Log Viewer window, select the message or trace log file window

where the files will be merged.
2. Click the File menu, then click Merge and choose a file to be merged.
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Sorting Message and Trace Logs
The Personal Communications log viewer utility allows you to sort message and
log files in ascending and descending order. To sort files in ascending order, click
the column header one time, or right mouse click the data. Click the column
header, or right mouse click the data a second time to sort in descending order.

Message and logs can also be sorted by selecting the data to be sorted, and right
mouse clicking to display the pop-up menu. Click Sort.

Searching Personal Communications Logs
To search the log files, click Edit → Find on the Main menu.

Type your search string in the provided box. You can refine your search by
checking the Match case check box if your search is to be case-specific. If you want
to limit your search to only complete words, select the Match whole word only
check box.

Clicking Find Next takes you to the next instance where your search string
appears highlighted in the log.

Clicking Cancel will stop the search.

Filtering Personal Communications Logs
Messages can be filtered by component only. Traces can be filtered by component,
by process ID, and by thread ID.

To filter the message or trace record list, do the following:
1. Decide what you want to filter by. For example, in the message log, you may

want to filter your view so that it contains only messages issued by a particular
component. (Filtering by component is the default.)

2. Click the left mouse button to highlight the item that has the value that you
want to filter by.

3. Right click in the appropriate column list area.
4. Click Filter In, Filter Out or Sort.

Filter In allows only those items selected to be in the resulting view. Filter Out
removes the selected items from the resulting view. Sort allows you to sort
entries in ascending or descending order based upon the entry selected. This
function works much like sorting by column header. Filters are cumulative, so
you can filter the results of your first filter.

To restore your original view, click View and then Refresh, or you can press F5.
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Part 3. Appendixes
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Appendix. Notices

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
500 Columbus Avenue
Thornwood, NY 10594
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM documentation or non-IBM Web
sites are provided for convenience only and do not in any manner serve as an
endorsement of those documents or Web sites. The materials for those documents
or Web sites are not part of the materials for this IBM product and use of those
documents or Web sites is at your own risk.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
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programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
Department T01
Building 062
P.O. Box 12195
RTP, NC 27709-2195
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement
or any equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

Trademarks
The following terms are trademarks of the IBM Corporation in the United States or
other countries, or both:

ACF/VTAM
APPN
AS/400
AnyNet
CICS
GDDM
IBM Global Network
IBM
IBMLink
OS/2

OS/400
OfficeVision
OfficeVision/MVS
PROFS
S/390
SAA
SP
System/390
VTAM

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems,
Inc. in the United States, other countries, or both.

Lotus is a trademark of Lotus Development Corporation in the United States, other
countries, or both.

PC Direct is a registered trademark of Ziff Communications Company and is used
by IBM Corporation under license.

UNIX is a registered trademark in the United States and other countries licensed
exclusively through X/Open Company Limited.

Notices
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C-bus is a trademark of Corollary, Inc.

LANDesk, MMX, Pentium, and ProShare are trademarks or registered trademarks
of Intel Corporation in the U.S. and other countries.

Other company, product, and service names may be trademarks or service marks
of others.

Trademarks
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